Thank You for Choosing Ross

You’ve made a great choice. We expect you will be very happy with your purchase of Ross Technology.

Our mission is to:
1. Provide a Superior Customer Experience
   - offer the best product quality and support
2. Make Cool Practical Technology
   - develop great products that customers love

Ross has become well known for the Ross Video Code of Ethics. It guides our interactions and empowers our employees. I hope you enjoy reading it below.

If anything at all with your Ross experience does not live up to your expectations be sure to reach out to us at solutions@rossvideo.com.

David Ross
CEO, Ross Video
dross@rossvideo.com

Ross Video Code of Ethics

Any company is the sum total of the people that make things happen. At Ross, our employees are a special group. Our employees truly care about doing a great job and delivering a high quality customer experience every day. This code of ethics hangs on the wall of all Ross Video locations to guide our behavior:

1. We will always act in our customers’ best interest.
2. We will do our best to understand our customers’ requirements.
3. We will not ship crap.
4. We will be great to work with.
5. We will do something extra for our customers, as an apology, when something big goes wrong and it’s our fault.
6. We will keep our promises.
7. We will treat the competition with respect.
8. We will cooperate with and help other friendly companies.
9. We will go above and beyond in times of crisis. If there’s no one to authorize the required action in times of company or customer crisis - do what you know in your heart is right. (You may rent helicopters if necessary.)
These limits are designed to provide reasonable protection against harmful interference when the equipment is operated in a Commercial environment. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instruction manual, may cause harmful interference to radio communications. Operation of this equipment in a residential area is likely to cause harmful interference in which case the user will be required to correct the interference at his own expense.

Notice — Changes or modifications to this equipment not expressly approved by Ross Video Ltd. could void the user’s authority to operate this equipment.

Canada
This Class A device complies with Canadian ICES-003 and part 15 of the FCC Rules.

Cet appareil numerique de la classe “A” est conforme a la norme NMB-003 du Canada.

European Union
This equipment is in compliance with the essential requirements and other relevant provisions established under regulation (EC) No 765/2008 and Decision No 768/2008/EC referred to as the “New Legislative Framework”.

Warning — This equipment is compliant with Class A of CISPR 32. In a residential environment this equipment may cause radio interference.

Australia/New Zealand
This equipment is in compliance with the provisions established under the Radiocommunications Act 1992 and Radiocommunications Labelling (Electromagnetic Compatibility) Notice 2008.

Korea
Class A equipment (Broadcasting and communications service for business use).
This device is a business-use (Class A) EMC-compliant device. The seller and user are advised to be aware of this fact. This device is intended for use in areas outside home.

<table>
<thead>
<tr>
<th>Type of Equipment</th>
<th>User’s Guide</th>
</tr>
</thead>
<tbody>
<tr>
<td>A급 기기 (업무용 방송통신기자재)</td>
<td>이 기기는 업무용(A급) 전자파적합기기로서 판매자 또는 사용자는 이 점을 주의하시기 바라며, 기장외의 지역에서 사용하는 것을 목적으로 합니다.</td>
</tr>
<tr>
<td>Class A Equipment (Industrial Broadcasting &amp; Communication Equipment)</td>
<td>This equipment is <strong>Industrial (Class A) electromagnetic wave suitability equipment</strong> and seller or user should take notice of it, and this equipment is to be used in the places except for home.</td>
</tr>
</tbody>
</table>

International
This equipment has been tested under the requirements of CISPR 22:2008 or CISPR 32:2015 and found to comply with the limits for a Class A Digital device.

Notice — This is a Class A product. In domestic environments, this product may cause radio interference, in which case the user may have to take adequate measures.

Maintenance/User Serviceable Parts
Routine maintenance to this Ross product is not required. This product contains no user serviceable parts. If the module does not appear to be working properly, please contact Technical Support using the numbers listed under the section “Contacting Technical Support”. This product
is covered by a generous 1-year warranty and will be repaired without charge for materials or labor within this period. See the section “Warranty and Repair Policy” for details.

Environmental Information

The equipment may contain hazardous substances that could impact health and the environment. To avoid the potential release of those substances into the environment and to diminish the need for the extraction of natural resources, Ross Video encourages you to use the appropriate take-back systems. These systems will reuse or recycle most of the materials from your end-of-life equipment in an environmentally friendly and health conscious manner.

The crossed-out wheeled bin symbol invites you to use these systems.

If you need more information on the collection, reuse, and recycling systems, please contact your local or regional waste administration. You can also contact Ross Video for more information on the environmental performances of our products.
<table>
<thead>
<tr>
<th>Company Address</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Ross Video Limited</strong></td>
</tr>
<tr>
<td>8 John Street</td>
</tr>
<tr>
<td>Iroquois, Ontario</td>
</tr>
<tr>
<td>Canada, K0E 1K0</td>
</tr>
<tr>
<td><strong>Ross Video Incorporated</strong></td>
</tr>
<tr>
<td>P.O. Box 880</td>
</tr>
<tr>
<td>Ogdensburg, New York</td>
</tr>
<tr>
<td>USA 13669-0880</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>General Business Office:</th>
<th>(+1) 613 • 652 • 4886</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fax:</td>
<td>(+1) 613 • 652 • 4425</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Technical Support:</th>
<th>(+1) 613 • 652 • 4886</th>
</tr>
</thead>
<tbody>
<tr>
<td>After Hours Emergency:</td>
<td>(+1) 613 • 349 • 0006</td>
</tr>
</tbody>
</table>

| E-mail (Technical Support): | techsupport@rossvideo.com  |
| E-mail (General Information): | solutions@rossvideo.com  |
| Website:                   | http://www.rossvideo.com   |
Contents

Introduction ................................................................. 11
Related Publications ..................................................... 11
Documentation Conventions ........................................... 12
Interface Elements ....................................................... 12
User Entered Text ........................................................ 12
Referenced Guides ....................................................... 12
Menu Sequences .......................................................... 12
Important Instructions .................................................. 12
Contacting Technical Support ....................................... 12

Before You Begin .......................................................... 13
Features ........................................................................ 13
What are Receivers, Senders, and Streams? ...................... 13
Operation ...................................................................... 14
Installation and Setup Overview ..................................... 14

Hardware Overview ...................................................... 15
Chassis Faceplate Overview ............................................ 15
PSU Connection and PWR Status LED ......................... 15
Power (PWR) Status LED .............................................. 16
PSU 15V 4A Connection ............................................... 16
Video Connections ....................................................... 16
SDI Connections ......................................................... 16
HDMI-SDI DIP Switch ................................................... 16
HDMI 2.0 Port .............................................................. 17
Communications Overview ........................................... 17
STATUS LED .............................................................. 17
CONTROL Port ............................................................ 18
NET 1, NET 2 Ports ...................................................... 18
Other Features ............................................................ 19
Reset Button .............................................................. 19
Micro SD Card Slot ...................................................... 19

Physical Installation ....................................................... 21
Static Discharge .......................................................... 21
Working with Fiber Optic Connectors ............................. 21
Unpacking .................................................................... 21
Mounting and Installing the NEWT-IPX ......................... 21

Cabling ........................................................................ 23
Connecting to a 15V PSU .............................................. 23
Cabling the CONTROL Port ......................................... 23
Cabling the NET Ports .................................................. 24
Cabling the SDI Ports for an IP to 4x3G-SDI Gateway .......... 24
Installing the NEWT-IPR-3G-4S License Key .................. 24
Setting the Operational Mode to IP to 4x3G-SDI Gateway .... 25
Cabling the SDI Ports for a 2-in/2-out SDI/IP Converter ....... 25
Installing the NEWT-IPX-3G-4S License Key ................. 25
Setting the Operational Mode to 2-in/2-out SDI/IP Converter 25
Connecting an External Device to the HDMI Port ............... 25
Setting up the Network Streams 53
  Overview .............................................................................................................................................. 53
  Advertised Streams ............................................................................................................................... 53
  Manually Assigning a Stream .............................................................................................................. 53
  Adding a Network Stream .................................................................................................................... 53
  Mapping the Audio Channels .............................................................................................................. 55

Operation 57
  Connections Tab Overview .................................................................................................................... 57
  Routing the Signals ............................................................................................................................... 58
  Performing a Breakaway ....................................................................................................................... 59
  Automatic Sender Session Description Protocol (SDP) Updates ....................................................... 59

SQD Setup 61
  What is Square Division Quad Split (SQD)? ....................................................................................... 61
  How does SQD differ from 2 Sample Interleave (2SI)? ..................................................................... 61
  Features ................................................................................................................................................ 61
  Setup Overview ................................................................................................................................... 61
  Configuring the HDMI Output ............................................................................................................. 62
  Adding an SQD Video Stream to the NEWT-IPX ............................................................................... 62
  Connecting the SQD Video Stream to an Output on the NEWT-IPX .................................................. 63

HDMI Quad-Split Mode 65
  What is Quad Split? .............................................................................................................................. 65
  Features ................................................................................................................................................ 65
  Overview ................................................................................................................................................ 65
  Configuration Overview ....................................................................................................................... 66
  Enabling HDMI Quad-Split Mode ................................................................................................. 66
  Synchronize to PTP ............................................................................................................................. 67
  Configuring the Receivers ................................................................................................................... 67
  Configuring the Network Streams ...................................................................................................... 68
  Assigning a Stream to a QUAD Output .............................................................................................. 68
  Troubleshooting ................................................................................................................................. 69

Monitoring 71
  Monitoring the Streams ....................................................................................................................... 71
  Notes on Monitoring the Receiver Streams ....................................................................................... 71
  Monitoring the Video Streams .......................................................................................................... 72
  Monitoring the Ethernet Status ........................................................................................................ 73

Upgrading the Software 75

DashBoard Interface Overview 77
  Welcome Tab ......................................................................................................................................... 77
  Initial Setup Tab ................................................................................................................................. 77
  Connections Tab .................................................................................................................................. 78
  Destinations Area ............................................................................................................................... 78
  Stream Sources Area .......................................................................................................................... 79
  Network Streams Tab ........................................................................................................................ 80
  Advanced Tabs .................................................................................................................................... 82
  Status Tab .......................................................................................................................................... 82
  Device Setup Tab ................................................................................................................................ 85
Technical Specifications

Supported Video Formats .................................................................................................................. 109
NET 1, 2 Ports - Single Mode Connections .......................................................................................... 109
Transmitter Port ...................................................................................................................................... 109
Receiver Port ......................................................................................................................................... 110
NET 1, 2 Ports - Multi-mode Connections ............................................................................................. 110
Transmitter ........................................................................................................................................... 110
Receiver ............................................................................................................................................... 111
Multi-mode Fiber Link Length ................................................................................................................ 111
CONTROL Port ........................................................................................................................................ 111
SDI Outputs Specifications ..................................................................................................................... 111
HDMI Port Specifications ....................................................................................................................... 112
Power ..................................................................................................................................................... 112
Environment .......................................................................................................................................... 112
Dimensions .......................................................................................................................................... 113

Service Information

Troubleshooting Checklist ..................................................................................................................... 115
Warranty and Repair Policy ................................................................................................................... 115
In Case of Problems ............................................................................................................................. 116

Software Licenses

BSD .......................................................................................................................................................... 117
Dual GPL ................................................................................................................................................. 117
GPL ......................................................................................................................................................... 117
LGPL ......................................................................................................................................................... 122
MIT ............................................................................................................................................................ 123
zlib ............................................................................................................................................................ 123

Glossary

125
Introduction

This guide covers the installation, configuration, and use of the NEWT-IPX. The following chapters are included:

- “Introduction” summarizes the guide and provides important terms, and conventions.
- “Before You Begin” provides a brief product overview and installation requirements for the NEWT-IPX.
- “Hardware Overview” describes the NEWT-IPX hardware features and physical connections.
- “Physical Installation” provides information when installing the NEWT-IPX in your system.
- “Cabling” provides an overview of connecting external devices to the NEWT-IPX.
- “Getting Started” outlines how to display the NEWT-IPX interfaces in DashBoard.
- “Ethernet Settings” provides instructions for configuring the NEWT-IPX settings for basic network communications.
- “Licensed Features” provides information for managing the licensed features of your NEWT-IPX.
- “Protocol Setup” provides information for setting up media distribution via the NEWT-IPX using third-party protocols.
- “Configuring the Timing Settings” provides instructions for configuring the NEWT-IPX to use Precision Time Protocol, and specifying a reference source.
- “Configuring the Receivers” provides instructions for configuring a receiver channel for video streaming.
- “Configuring the Senders” provides instructions for configuring the sender channels on the NEWT-IPX when it is configured as an 2-in/2-out SDI/IP Converter.
- “Setting up the Network Streams” outlines how to define the network streams that the NEWT-IPX can access.
- “Operation” provides general information for operating the NEWT-IPX.
- “Monitoring” describes the monitoring of the receivers via the DashBoard interfaces.
- “Upgrading the Software” provides instructions for upgrading the software via DashBoard.
- “DashBoard Interface Overview” summarizes the functions, menus, and parameters of the NEWT-IPX in DashBoard.
- “Technical Specifications” provides the specifications for the NEWT-IPX.
- “Service Information” provides information on the warranty and repair policy for your NEWT-IPX.
- “Software Licenses” provides third-party software license information for your NEWT-IPX.
- “Glossary” provides a list of terms used throughout this guide.

Related Publications

It is recommended to consult the following Ross documentation before installing and configuring your NEWT-IPX:

- DashBoard User Manual, Ross Part Number: 8351DR-004
- NEWT-IPX Quick Start Guide, Ross Part Number: 1000DR-202
Documentation Conventions

Special text formats are used in this guide to identify parts of the user interface, text that a user must enter, or a sequence of menus and sub-menus that must be followed to reach a particular command.

Interface Elements

Bold text is used to identify a user interface element such as a dialog box, menu item, or button. For example:

In the **Edit** dialog, click **Apply**.

User Entered Text

Courier text is used to identify text that a user must enter. For example:

In the **Language** box, enter **English**.

Referenced Guides

Italic text is used to identify the titles of referenced guides, manuals, or documents. For example:

For more information, refer to the *DashBoard User Manual*.

Menu Sequences

Menu arrows are used in procedures to identify a sequence of menu items that you must follow. For example, if a step reads **“File > Save As,”** you would select the **File** menu and then select **Save As**.

Important Instructions

Star icons are used to identify important instructions or features. For example:

★ Contact your IT department before connecting to your facility network to ensure that there are no conflicts. They will provide you with an appropriate value for the IP Address, Subnet Mask, and Gateway for your NEWT-IPX.

Contacting Technical Support

At Ross Video, we take pride in the quality of our products, but if problems occur, help is as close as the nearest telephone.

Our 24-hour Hot Line service ensures you have access to technical expertise around the clock. After-sales service and technical support is provided directly by Ross Video personnel. During business hours (Eastern Time), technical support personnel are available by telephone. After hours and on weekends, a direct emergency technical support phone line is available. If the technical support person who is on call does not answer this line immediately, a voice message can be left and the call will be returned shortly. This team of highly trained staff is available to react to any problem and to do whatever is necessary to ensure customer satisfaction.

- **Technical Support:** (+1) 613-652-4886
- **After Hours Emergency:** (+1) 613-349-0006
- **E-mail:** techsupport@rossvideo.com
- **Website:** http://www.rossvideo.com
Before You Begin

If you have questions pertaining to the operation of the NEWT-IPX, contact us at the numbers listed in the section “Contacting Technical Support”. Our technical staff is always available for consultation, training, or service.

Features

Some features of the NEWT-IPX include:

• Supports UHD, HD, and 3G video formats (refer to Table 27)
• Provides four SMPTE ST 2110-20 video receivers
• Provides up to eight SMPTE ST 2110-30 audio receivers:
  › 16 audio channels per SDI interface; 8 audio channels to HDMI 2.0 interface
  › 24bit, 48kHz channel frequency
  › 125us, and 1ms packet times
• Provides protection switching using hitless merge of all streams per SMPTE ST 2022-7
• Select between four SDI outputs or one HDMI 2.0 output, or two SDI inputs and two SDI outputs
• HD/3G and UHD-over-IP
• RAVENNA Session announcement, discovery, and registration
• NMOS IS-04 and IS-05 discovery, registration, and connection control
• Ember+ (BESS 1.1) connection control
• Full DashBoard control

What are Receivers, Senders, and Streams?

The following terms are used throughout this user guide:

Device

A physical, virtual, or software application that may include multiple sources, destinations, senders, or receivers.

Essence

A single elementary logical media signal. For example, a video essence is one video channel. An audio essence is a single audio (mono) channel.

Flow

The continuous raw media content. It can contain more than one essence (e.g. an audio flow can contain multiple channels, and an SDI flow may contain audio and video essences).

A flow is independent of the transport protocol. For example, 48kHz LPCM audio is a flow; AES67 is one type of stream which can carry the flow.

Flows cannot generally be passed around natively, and need to be encapsulated in a stream. Flows from the same source are considered “editorially equivalent”, but may be encoded differently. For example, a video source may be encoded as 4:2:2 YCbCr uncompressed, 4:4:4 RGB uncompressed, and h.265 encoded. Each of these would be a separate flow from a common source.
Receiver
An element within a device that receives exactly one stream, which contains one flow from a network.

Sender
An element within a device which presents exactly one flow, packaged as a stream onto a network.

Stream
One flow, encapsulated within a transport protocol. Examples include SMPTE ST 2022-6, SMPTE ST 2110-20 Video, or SMPTE ST 2110-30 Audio (AES67).

For More Information on...
• additional terms used in this guide, refer to “Glossary”.

What is UHD?
The acronym “UHD” stands for Ultra High Definition (3840 x 2160). It represents a resolution that is four times greater than that of the current HD format (1920 x 1080), which means more pixels for a better picture. When combined with other video innovations – such as HDR and OLED screens – UHD provides incredible detail for a much-improved viewing experience. It operates in many of the standard broadcast frame rates: 29.97, 30, 50, 59.94 and 60 frames per second. Today, this signal is more appropriately defined by SMPTE 2036-1.

You may also hear 4K mentioned in regards to cinematography. In this area, it refers to the Digital Cinema Initiatives 4K (DCI 4K - 4096 x 2160) format. This format is four times the resolution of the cinema standard 2K resolution (2048 x 1080). For this article, we will be solely focused on the broadcast UHD format.

Operation
The NEWT-IPX can be configured as a SMPTE ST 2110 point-of-use box in the following modes:
• 2x10GE RX to 1xHDMI 2.0 output
• 2x10GE RX to 4xSDI outputs
• 2x10GE RX/TX and 2xSDI inputs + 2xSDI outputs

For More Information on...
• licensed features, refer to “Licensed Features”.
• configuring the NEWT-IPX outputs, refer to “Specifying an Operational Mode”.

Installation and Setup Overview
The generalized work-flow of installing and configuring your NEWT-IPX is:
1. Download and install the latest version of the DashBoard client software.
2. Contact your IT department for the required IP addresses for your NEWT-IPX.
3. Physically install and cable the NEWT-IPX.
4. Use DashBoard to access the NEWT-IPX.
5. Use the Newt Setup Wizard to configure the basic settings for your module.
7. Make your connections.
Hardware Overview

This chapter presents information on the NEWT-IPX hardware components and features.

Chassis Faceplate Overview

The chassis faceplate of the NEWT-IPX provides a silk-screen map of the connections and LEDs available. Figure 1 illustrates the NEWT-IPX faceplate top. From the top you can see that the chassis is organized into two distinct areas:
- the power connection, SDI BNCs, and HDMI port are located on the right side
- the communications ports (e.g. RJ45 and NET modules) are located on the left side

![Figure 1 NEWT-IPX — Faceplate Components](image)

PSU Connection and PWR Status LED

The right-side of the NEWT-IPX chassis provides a PSU port and a Status LED to monitor the PSU port. (Figure 2)

![Figure 2 NEWT-IPX — POWER](image)
Power (PWR) Status LED

*Table 1* describes the possible status information the PWR LED will report.

<table>
<thead>
<tr>
<th>Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Green</td>
<td>When this LED is continually lit green, the NEWT-IPX is receiving +15VDC on the PSU (DC) port of its chassis.</td>
</tr>
<tr>
<td>Red</td>
<td>The NEWT-IPX is initializing/booting up.</td>
</tr>
<tr>
<td>Off</td>
<td>When this LED is unlit, the PSU port is not receiving power.</td>
</tr>
</tbody>
</table>

PSU 15V 4A Connection

The NEWT-IPX is powered from an external 15V PSU. This port is a standard miniature power jack (center pin positive). Refer to “Connecting to a 15V PSU” for details.

Video Connections

The right-side of the NEWT-IPX chassis also provides four connections for SDI signals. (*Figure 3*) Depending on the Operational Mode, the SDI BNCs can be inputs or outputs.

For More Information on...

- specifying the Operational Mode for the NEWT-IPX, refer to “Specifying an Operational Mode”

![Figure 3 NEWT-IPX — Video Connections](image)

SDI Connections

When configured as an IP to 4x3G-SDI Gateway, the SDI 1, 2, 3, and 4 BNCs output SDI signals up to 3Gbps. These connectors are mapped 1:1 to the NEWT-IPX receivers.

When configured as an 2-in/2-out SDI/IP Converter, SDI 1 and 2 are inputs and SDI 3 and 4 are outputs.

HDMI-SDI DIP Switch

It is recommended to leave the HDMI-SDI DIP Switch in its default position. If you wish to switch the output type from HDMI to SDI or vice versa, refer to “Specifying an Operational Mode”.
HDMI 2.0 Port
This port provides an HDMI 2.0 output. To enable the HDMI output you must:
- install the NEWT-IPR-UHD-H license key, and
- set the **Advanced > Device Setup > Operational Mode on Reboot**, in DashBoard, to **UHD-over-IP to HDMI 2.0 Gateway**

For More Information on...
- installing license keys, refer to “Licensed Features”.
- selecting an operational mode, refer to “Specifying an Operational Mode”.

Communications Overview
The left-side of the NEWT-IPX chassis provides ports for connecting to your facility network. ([Figure 4](#)) A STATUS LED enables you to monitor the communication traffic on the NEWT-IPX.

![STATUS LED](image)

**Table 2** desribes the STATUS LED reports on the communication activity of the NEWT-IPX.

<table>
<thead>
<tr>
<th>Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Green</td>
<td>No errors are detected in the communication activity between the NEWT-IPX and external devices.</td>
</tr>
<tr>
<td>Yellow/Green</td>
<td>The NEWT-IPX is waiting for PTP to lock.</td>
</tr>
<tr>
<td>Blue</td>
<td>The NEWT-IPX is updating (e.g. uploading new firmware, applying a new Operational Mode). Do not power down the NEWT-IPX until the process completes.</td>
</tr>
<tr>
<td>Red</td>
<td>A communication error is detected or the NEWT-IPX is currently in reboot mode. Monitor the NEWT-IPX status before taking action.</td>
</tr>
<tr>
<td>Off</td>
<td>The NEWT-IPX is not powered on.</td>
</tr>
</tbody>
</table>
CONTROL Port

The CONTROL port is an RJ45 port for connecting to your facility network. This connection is used to communicate with a DashBoard client for configuration and monitoring purposes.

Connect NEWT-IPX to the same network as your DashBoard client computer or to a network that has a route to the network your DashBoard client computer is on.

The CONTROL port also features two LEDs that report the link status and speed for the NEWT-IPX. (Figure 5)

![Figure 5 NEWT-IPX — CONTROL LEDs](image)

Table 3 summarizes the CONTROL LEDs behavior.

**Table 3 CONTROL LEDs**

<table>
<thead>
<tr>
<th>Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Status LED</td>
<td></td>
</tr>
<tr>
<td>Green</td>
<td>When lit green, this LED indicates the link is up</td>
</tr>
<tr>
<td>Off</td>
<td>When unlit, this LED indicates the link is down</td>
</tr>
<tr>
<td>Link Activity LED</td>
<td></td>
</tr>
<tr>
<td>Green</td>
<td>When lit solid green, this LED indicates the link is operating at 1000Mbps but no data is currently transferred</td>
</tr>
<tr>
<td>Flashing Green</td>
<td>When flashing green, this LED indicates that data is currently transferred at 1000Mbps</td>
</tr>
<tr>
<td>Orange</td>
<td>When lit solid orange, this LED indicates the link is operating at 100Mbps but no data is currently transferred</td>
</tr>
<tr>
<td>Flashing Orange</td>
<td>When flashing orange, this LED indicates that data is currently transferred at 100Mbps</td>
</tr>
<tr>
<td>Off</td>
<td>When unlit, this LED indicates that data is not being transferred</td>
</tr>
</tbody>
</table>

NET 1, NET 2 Ports

Each NET port can be populated with Small Form-factor Pluggable (SFP) modules from the factory or by installing modules in the field. Contact Ross Technical Support for a list of SFPs available from Ross Video.

If a NET port is populated on the NEWT-IPX chassis, its status is reported in DashBoard. Depending on the Operational Mode, there are options provided for configuring the NEWT-IPX NET ports as a receiver and/or transmitter.
Other Features

The left-side of the NEWT-IPX chassis also provides a Reset button and a Micro SD Slot. (Figure 6)

Figure 6  NEWT-IPX — Other Features

Reset Button
Pressing this button resets the microprocessor and re-initializes the NEWT-IPX. This is a hard reset of the module settings, including the IP Address, to the factory default values.

Micro SD Card Slot
This slot is used in the case of a software upgrade failure and under the guidance of Ross Technical Support. This slot is not populated with a Micro SD Card when shipped from the factory.

★ If the NEWT-IPX fails to upgrade correctly, contact Ross Technical Support for an upgrade file and instructions on using the Micro SD Card slot.
Physical Installation

If you have questions pertaining to the installation of NEWT-IPX, please contact us at the numbers listed in the section “Contacting Technical Support”. Our technical staff is always available for consultation, training, or service.

For More Information on...
• the technical specifications for the NEWT-IPX, refer to “Technical Specifications”.

Static Discharge
Throughout this guide, please heed the following cautionary note:

ESD Susceptibility — Static discharge can cause serious damage to sensitive semiconductor devices. Avoid handling circuit boards in high static environments such as carpeted areas and when synthetic fiber clothing is worn. Always exercise proper grounding precautions when working on circuit boards and related equipment.

Working with Fiber Optic Connectors
The NEWT-IPX supports up to two optical Small Form-factor Pluggable (SFP) modules. Keep the following in mind when working with fiber optic connectors:
• Every time you are required to insert a connector into a device or mating sleeve, you must clean the connector. All exposed surfaces of the ceramic ferrule must be clean. Follow your facility practices of cleaning fiber optic connectors.
• Connectors must always be inserted into a device or have a dust cap on.
• A poor optical connection is often similar to a poor electrical connection. Try removing the connector, cleaning, and re-inserting the connector. A bad connection can result in experiencing instability of signal, high loss, or a noisy signal.

Unpacking
Unpack each NEWT-IPX you received from the shipping container and ensure that all items are included. If any items are missing or damaged, contact your sales representative or Ross Video directly.

Mounting and Installing the NEWT-IPX
NEWT-IPX can be mounted in any convenient location. However, to ensure long life for this product, observe the following precautions and operating requirements:
• Maintain an ambient temperature of 0°C to 40°C (32°F to 104°F).
• Allow for air circulation around the chassis for convectional cooling.

Many different mounting positions are possible. Some installation options are permanent and require careful consideration of the final positioning before installation.
• In some mounting locations, the power adapter must be affixed in a similar manner as the chassis.

Cable ties may be necessary in some applications to relieve strain on the mounting hardware and the connectors.
For More Information on...

- installation and mounting your NEWT-IPX, refer to the NEWT-IPX Quick Start Guide.
- how to install the NEWT-IPX with an optional mounting kit, refer to the install guide that shipped with your kit.
Cabling

If you have questions pertaining to the setup of NEWT-IPX, contact us at the numbers listed in the section “Contacting Technical Support”. Our technical staff is always available for consultation, training, or service.

For More Information on...
• the technical specifications for the NEWT-IPX, refer to “Technical Specifications”.
• notices to service personnel, refer to the document Important Regulatory and Safety Notices that shipped with your NEWT-IPX.
• installing a license key for the NEWT-IPX, refer to “Licensed Features”.
• selecting an operating mode for the NEWT-IPX, refer to “Specifying an Operational Mode”.

Connecting to a 15V PSU

The NEWT-IPX ships with the required power supply. This power supply provides regulated +15V DC (5%) @ up to 4A. The DC Power cord has a locking connector that securely fastens into the power supply DC jack on the NEWT-IPX chassis.

**Warning** — The power supply connector of the NEWT-IPX power supply module must be fully inserted into the NEWT-IPX PSU port and the locking collar fully secured before use. Failure to do so may damage the PSU port on the NEWT-IPX chassis.

**Caution** — Ensure to connect the DC Power cord of the power supply to the POWER jack on the NEWT-IPX before connecting the power supply to the power source.

**Caution** — Use of improper adapters may damage the NEWT-IPX and will void the warranty.

Cabling the CONTROL Port

The NEWT-IPX is connected directly to your network so that it can interface with the devices and the computer running the DashBoard client. After a physical connection is established, DashBoard is used to configure the network settings for the NEWT-IPX.

☆ Contact your IT department before connecting to your facility network to ensure that there are no conflicts. They will provide you with an appropriate value for the IP Address, Subnet Mask, and Gateway for your device.

☆ If difficulties or problems are experienced when connecting the NEWT-IPX to a network hub, contact your network administrator.

The exact steps for connecting your NEWT-IPX to your facility via an Ethernet network depend on the network requirements of your facility.
Cabling the NET Ports

⚠️ **Caution** — Never attempt to look down the barrel of a connected fiber or device transmitting an optical signal. The transmitted light is not in the visible spectrum and may cause permanent eye damage. Turn off all laser sources before disconnecting devices.

The primary function of each NET port is to provide a 10GbE network interface that can be configured as a Receiver and/or a Sender in DashBoard.

* The NET ports are bi-directional if the NEWT-IPX will operate as an 2-in/2-out SDI/IP Converter. For other Operation Modes, the NET ports are Receivers only.

**To cable a NET port**

⚠️ **Caution** — Every time you are required to insert a connector into a device or mating sleeve, you must clean the connector. All exposed surfaces of the ceramic ferrule must be clean. Follow your facility practices of cleaning fiber optic connectors. Connectors must always be inserted into a device or have a dust cap on.

1. Remove the dust caps from each NET port connector on the NEWT-IPX chassis.

   * Refer to the document *Important Regulatory and Safety Notices* that shipped with your module, for safety information when handling fiber optic components.

2. Ensure that the exposed surface of the ceramic ferrule of each connector is clean. Refer to “Working with Fiber Optic Connectors” for cleaning tips.

3. Cable your SFP module as required. ([Figure 7](#))

![Figure 7](#)  
*Figure 7  NEWT-IPX — NET Port Connections*

Cabling the SDI Ports for an IP to 4x3G-SDI Gateway

If your NEWT-IPX will be used as an IP to 4x3G-SDI Gateway, connect up to four SDI destination devices to the SDI BNCs on the NEWT-IPX chassis as outlined in [Figure 8](#).

![Figure 8](#)  
*Figure 8  NEWT-IPX Cabling — Four SDI Outputs*

Installing the NEWT-IPR-3G-4S License Key

To enable the SDI outputs, the NEWT-IPR-3G-4S license key must be installed. Refer to “Licensed Features” for details.
Setting the Operational Mode to IP to 4x3G-SDI Gateway

You must set the Operational Mode to IP to 4x3G-SDI Gateway as outlined in “Specifying an Operational Mode”.

Cabling the SDI Ports for a 2-in/2-out SDI/IP Converter

If your NEWT-IPX will be used as a 2-in/2-out SDI/IP Converter, there are two SDI inputs and two SDI outputs. Connect your external devices to the SDI BNCs on the NEWT-IPX chassis as outlined in Figure 9.

![Figure 9 2-in/2-out SDI Cabling — SDI Connections](image)

Installing the NEWT-IPX-3G-4S License Key

To enable the SDI outputs, the NEWT-IPX-3G-4S license key must be installed. Refer to “Licensed Features” for details.

Setting the Operational Mode to 2-in/2-out SDI/IP Converter

You must set the Operational Mode to 2-in/2-out SDI/IP Converter as outlined in “Specifying an Operational Mode”.

Connecting an External Device to the HDMI Port

The NEWT-IPX can provide one HDMI 2.0 output when configured as an UHD-over-IP HDMI 2.0 Gateway.

Cabling the HDMI Port

Connect your HDMI destination device to the HDMI OUT port on the NEWT-IPX chassis. (Figure 10)

![Figure 10 NEWT-IPX Cabling — HDMI OUT](image)

Installing the NEWT-IPR-UHD-H License Key

To enable the HDMI output, the NEWT-IPR-UHD-H license key must be installed. Refer to “Licensed Features” for details.
Setting the Operational Mode to UHD-over-IP to HDMI 2.0 Gateway

You must set the Operational Mode to UHD-over-IP to HDMI 2.0 Gateway as outlined in “Specifying an Operational Mode”.
Getting Started

This chapter provides instructions for launching DashBoard, assigning an initial IP address to the NEWT-IPX, and accessing the tabs and menus in DashBoard.

Before You Begin

These installation guidelines assume the following:

• a valid IPV4 address is available for the NEWT-IPX
• a PTP Grandmaster is configured and accessible for the NEWT-IPX
• a network switch is configured in Boundary Clock mode and available for communicating with the NEWT-IPX

* Ensure that your facility IT Department provided the required network settings to be assigned to the NEWT-IPX and each NET port you plan to enable.

Configuration Overview

Figure 11 summarizes the generalized workflow of configuring your NEWT-IPX.

Launching DashBoard

The DashBoard client software enables you to monitor, configure, and operate your NEWT-IPX. The NEWT-IPX groups the configuration, monitoring, and operating features as a series of tabs in the DashBoard client window. Each tab provides access to specific configuration options for your NEWT-IPX.

* DashBoard must run on a computer that has a physical wired Ethernet connection directly to the NEWT-IPX and configured with an IP address in the same range as the default address of the NEWT-IPX (192.168.0.100).

For More Information on...

• downloading and using the DashBoard client software, refer to the DashBoard User Manual.
• the NEWT-IPX interfaces in DashBoard, refer to “DashBoard Interface Overview”.

To launch DashBoard

1. Ensure that you are running DashBoard software version 9.0.0 or higher.
2. Launch DashBoard by double-clicking its icon on your computer desktop.

Using Walkabout to Assign the Initial IP Address to NEWT-IPX

Once the NEWT-IPX is physically installed and cabled to your facility network, you will need to assign it an initial static IP Address to enable DashBoard to locate it on your network. Establishing an initial IP Address enables DashBoard to communicate with NEWT-IPX and update the Basic Tree View with the NEWT-IPX node.
To assign the initial static IP address for the NEWT-IPX

1. Launch DashBoard.
2. From the DashBoard client main toolbar, select File > Show Walkabout.
   The DashBoard window displays the Walkabout table.
3. Click Refresh, located at the bottom of the Walkabout tab, to ensure the list in the Walkabout interface is current.
4. In the Walkabout table, find the entries for the NEWT-IPX you want to configure.
   Each NEWT-IPX has three entries in the table: CONTROL, NET 1, and NET 2. These are the physical RJ45 ports on the NEWT-IPX chassis. You need only assign an IP Address to the CONTROL port for initial setup of the NEWT-IPX.
5. Use the Name field to assign a unique identifier to the NEWT-IPX. This will be the name displayed in the Tree View of DashBoard.
6. Use the Address field to specify the IP Address supplied by your IT Department for this device.
   After you edit a cell in the Walkabout table, it is recommended to wait approximately 1 minute, then click Refresh to apply the new settings.
7. Ensure the Netmask field is set to match your network requirements.
8. Use the Gateway field to specify the IP Address for connection outside of the local area network (LAN).
9. Click Reboot in the row of the Walkabout table for the NEWT-IPX.

Manually Adding the NEWT-IPX to the Tree View

The Tree View lists all DashBoard Connect devices that the DashBoard client can communicate with. Once you have added the NEWT-IPX to the Tree View, you can access its interfaces.

The NEWT-IPX does not automatically display the DashBoard Tree View. You must manually add it to the Tree View.

To manually add the NEWT-IPX to the Tree View in DashBoard

1. From the main toolbar in DashBoard, select File > New > TCP/IP DashBoard Connect or openGear Device.
   The New TCP openGear Frame Connection dialog opens.
2. In the IP Address field, enter the IP Address you assigned to the CONTROL port of the NEWT-IPX in step 6 of the procedure “To assign the initial static IP address for the NEWT-IPX”.
3. Enter a unique identifier for the NEWT-IPX in the **Display Name** field.
   ✴ This is the name displayed in the DashBoard Tree View.
4. Click **Finish** to close the dialog.
5. Verify that the **NEWT** node displays in the DashBoard Tree View.
6. Expand the **NEWT** node (with the name assigned in step 3) in the Tree View.
7. Double-click the **NEWT** sub-node.
   The NEWT-IPX displays in DashBoard with the **Welcome** tab automatically selected.

### Using the Newt Setup Wizard

The **Newt Setup Wizard** is displayed when the **Initial Setup** tab is selected in DashBoard. *(Figure 12)*

![Figure 12 Example of the Initial Setup Tab](image)

Use the **Newt Setup Wizard** to configure the following settings:

- IP Address for the CONTROL port
- IP Address for each NET port
• Licensed features
• Operational Mode
• System Frame Rate
• PTP Timing System
• Senders
These steps are further described in the proceeding chapters.

Accessing the NEWT-IPX Interfaces in DashBoard

The NEWT-IPX groups the configuration, monitoring, and operating features as a series of tabs in the DashBoard client window. Each tab provides access to specific configuration options for your NEWT-IPX.

The interfaces are accessed by double-clicking the NEWT-IPX node in the DashBoard Tree View. This procedure assumes that you have launched DashBoard on your computer and a valid IP Address is assigned to the NEWT-IPX.

To access the NEWT-IPX interfaces in DashBoard
1. In the Basic Tree View of DashBoard, expand the top NEWT-IPX node.
2. Expand the NEWT sub-node.
3. Double-click the second NEWT sub-node to display the NEWT-IPX interface in the right pane of the DashBoard window.

When first accessing the NEWT-IPX interface, the Welcome tab is automatically displayed in DashBoard.

Once the initial settings are configured and applied to the NEWT-IPX, you can hide the Welcome and Initial Setup tabs by selecting the Initial Setup tab and the Hide Welcome tab and/or Hide Initial Setup Wizard tab options. You must then click Refresh (located at the bottom of the DashBoard window) to apply the new setting(s).
Ethernet Settings

The NEWT-IPX provides two NET ports that can be populated with Ethernet fiber-optic connectors. The chassis also provides one Ethernet RJ45 (CONTROL) port that is used to connect to your facility network for DashBoard communication. This chapter outlines how to configure each of these ports.

Contact your network administrator if difficulties or problems are experienced when assigning IP addresses.

Configuring the CONTROL Port

The CONTROL port is located on the left side of the NEWT-IPX chassis. Once the NEWT-IPX is communicating via DashBoard, you may wish to assign a different static IP Address from the factory default value (which was used to initially establish a connection point to the NEWT-IPX).

To assign the initial network settings for the NEWT-IPX

1. Display the NEWT-IPX interfaces in DashBoard as outlined in “To access the NEWT-IPX interfaces in DashBoard”.
2. Select the Initial Setup tab.
3. Locate the menus for the CONTROL port.
4. Use the Mode menu to select Static.
5. Use the Static IP Address field to assign a unique IP Address to the NEWT-IPX.
6. Use the Static Subnet Mask field to assign the subnet mask for the NEWT-IPX.
7. Use the Advanced > Ethernet I/O > Gateway field to specify the gateway for communications outside of the local area network (LAN) the NEWT-IPX will use.
8. Click Apply.
9. Click Reboot to apply the new settings. This button is located at the bottom of the interface. The NEWT-IPX is temporarily taken off-line during the reboot.
10. Verify the new network settings reported on the Advanced > Ethernet I/O tab.
Configuring the NET Ports

By assigning an IP Address to each NET port (NET 1, NET 2), you are able to uniquely identify it on the network and control it via the DashBoard interface. Each NET port can be configured for media traffic for the NEWT-IPX.

This section outlines how to configure the network settings for the NET ports on the chassis.

For More Information on...
- the NET designations, refer to “Communications Overview”.

To update the network settings for a NET port

1. Display the NEWT-IPX interfaces in DashBoard as outlined in “To access the NEWT-IPX interfaces in DashBoard”.
2. Select the Initial Setup tab.
   - You can also change these settings via the Advanced > Ethernet I/O tab.
3. Locate the options for the NET port you wish to configure.
4. If you are manually configuring the Ethernet settings:
   a. Use the Mode menu to select Static.
   b. Use the Static IP Address field to specify the new static IP Address for the NEWT-IPX. This is the IP Address that is used to control and communicate with the specific NET port.
   c. Use the Subnet Mask field to specify the subnet mask for the NET port.
   d. Use the Gateway field to specify the gateway for communications outside of the local area network (LAN) the NEWT-IPX will use.
   - Use the Advanced > Ethernet I/O > Gateway field to specify the gateway for the NET port.
5. If you want the network settings for the NET port to be automatically obtained, and DHCP service is available on your control network, select DHCP from the Mode menu.
6. Click Apply to save the new settings.
7. Repeat this procedure for the second NET port you wish to configure.
8. Click Reboot to apply the new settings. This button is located at the bottom of the interface. The NEWT-IPX is temporarily taken off-line during the reboot.
9. Verify the new settings reported on the Advanced > Ethernet I/O tab.
Licensed Features

The NEWT-IPX has software licenses for enabling functions and features of the module. This chapter outlines the available software licensed features, and how to install a software key for a licensed feature.

License Keys Overview

Table 4 provides a brief summary on the types of licensed features available for the NEWT-IPX.

<table>
<thead>
<tr>
<th>License</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>NEWT-IPR-3G-4S</td>
<td>IP to 4x3G-SDI gateway</td>
</tr>
<tr>
<td>NEWT-IPR-UHD-H</td>
<td>UHD-over-IP to HDMI 2.0 gateway</td>
</tr>
<tr>
<td>NEWT-IPX-3G-4S</td>
<td>2-in/2-out SDI/IP Converter</td>
</tr>
</tbody>
</table>

Installing a License Key

Ross Video uses license keys to control user access to specific NEWT-IPX features. You can obtain a key for an NEWT-IPX licensed feature from Ross Video Technical Support.

To install an NEWT-IPX license key

1. Display the NEWT-IPX interfaces in DashBoard as outlined in “To access the NEWT-IPX interfaces in DashBoard”.
2. Select the Initial Setup tab.
3. Scroll down the tab to display the Licenses table.
4. Make a note of the character string in the Request Code field for the feature you wish to enable.
5. Contact Ross Video Technical Support using the information found in “Contacting Technical Support”.
   a. When you speak to your Technical Support representative, tell them your name, your facility name, and the Request Code from the Licenses table.
   b. You will be given a License Key that must be entered in the applicable field in the Licenses table.
6. Enter the provided License Key in the applicable License Key field in the Licenses table.
7. Click Apply in the row for the License Key you entered in step 6.
8. Verify that the Count field is updated to report each installed License Key.
Removing a License Key

* Disabling a License Key removes user access to the NEWT-IPX features associated with that License Key.

**To remove a NEWT-IPX license key**

1. Display the NEWT-IPX interfaces in DashBoard as outlined in “To access the NEWT-IPX interfaces in DashBoard”.
2. Select Advanced > Licensing.
3. If required, scroll to the Licenses table.
4. Click in the field for the licensed feature you want to disable.
5. Type `remove`.
6. Click **Apply** to remove the license.
Protocol Setup

This chapter outlines how to specify which outputs to enable on the NEWT-IPX, enable the Protection Switching feature, and configure the NEWT-IPX for a specific media distribution protocol.

Specifying an Operational Mode

Before proceeding to configure your NEWT-IPX, you must first specify the Operational Mode for the module. This will determine the number of receivers to configure and the type of outputs available (SDI or HDMI).

**To specify an operational mode for the NEWT-IPX**

1. Display the NEWT-IPX interfaces in DashBoard as outlined in **“To access the NEWT-IPX interfaces in DashBoard”**.
2. Select the Initial Setup tab.
   ✳ You can also change these settings via the Advanced > Device Setup tab.
3. Locate the Select your desired operational mode buttons. You may need to scroll to the bottom of the tab to access these buttons.
4. Select the required mode button.
   ✳ If the mode button displays a red Lock icon, a license key is not installed to enable that mode. Refer to “Licensed Features” for details on installing a license key.
5. Click Apply.

**Notice** — Do not power down the NEWT-IPX during this procedure. Doing so may set the NEWT-IPX into a non-operational state.

6. Monitor the automatic NEWT-IPX reboot process.

Setting up Protection Switching

The NEWT-IPX enables a user to protect their streams to ensure mission critical operation. Using SMPTE ST 2022-7 they can run the same video and audio over two separate, redundant networks in case an error occurs with any hardware.

✳ This section is only applicable if your system requires protection switching.

**Before You Begin**

Ensure that:

• your source is capable of sending SMPTE ST 2022-7 streams
• the NEWT-IPX is set up with a protection switching network
Enabling the Protection Switching Feature

By default, the SMPTE ST 2022-7 Protection Switching feature is disabled. Once enabled, the Receivers, Senders\(^1\), and Network Streams tabs update to include options for configuring the Protection Switching streams.

\* This feature is reset when the **Load Factory Defaults** button is selected.

**To enable the Protection Switching feature**

1. Display the NEWT-IPX interfaces in DashBoard as outlined in “**To access the NEWT-IPX interfaces in DashBoard**”.
2. Select **Advanced > Device Setup**.
3. Select the **SMPTE ST 2022-7/Seamless Protection Switching** box.
4. Click **OK** in the prompt confirming that all sessions will be removed.
5. Click **Apply**.
6. Click **Reboot** to apply the new settings. This button is located at the bottom of the interface.
   - The NEWT-IPX is temporarily taken off-line during the reboot.
7. Monitor the reboot progress.

Configuring the NEWT-IPX for Protection Switching

You will need to assign a unique IP address to each **video** stream (e.g. primary 239.1.1.1, secondary IP 239.1.1.2).

**To configure the NEWT-IPX for protection switching**

1. Configure the primary and secondary Receiver streams as outlined in “**Configuring a Receiver**”.
   - The UDP value can be the same or different for the primary and secondary streams.
2. Configure the primary and secondary Network streams as outlined in “**Adding a Network Stream**”.
3. Click **Reboot**. This button is located on the bottom of the interface.
4. Monitor the reboot progress.

Registration and Discovery

The NEWT-IPX supports media distribution based on RAVENNA, RTSP, Ember+, SAP, SLP and NMOS. This section outlines how to configure the NEWT-IPX for each protocol.

RAVENNA Support

This section outlines how to configure the NEWT-IPX for the open standard for real-time media over IP (AES67).

**To configure the NEWT-IPX as a RAVENNA device**

1. Display the NEWT-IPX interfaces in DashBoard as outlined in “**To access the NEWT-IPX interfaces in DashBoard**”.
2. Select **Advanced > Discovery**.

---

\(^1\) If operating in 2in/2out mode.
3. Locate the **RAVENNA** area in the tab.

4. To re-name the NEWT-IPX for the RAVENNA network, perform one of the following:
   - Use the **Board Name** menu to specify a unique identifier for the NEWT-IPX in the RAVENNA network; or
   - Click **Use System Device Name**.

5. Use the **Interface** menu to specify what physical port the NEWT-IPX uses for RAVENNA communications.

6. Use the **Port** menu to specify the port assigned to the NEWT-IPX within the RAVENNA network.

7. Click **Apply** to save the new settings.

8. Click **Reboot** to apply the new settings. This button is located at the bottom of the interface. The NEWT-IPX is temporarily taken off-line during the reboot.

9. Monitor the reboot progress.

---

**RTSP Support**

This section outlines the required settings when establishing communications between NEWT-IPX and an external device via the Real Time Streaming Protocol (RTSP).

**To configure the NEWT-IPX as a RTSP device**

1. Display the NEWT-IPX interfaces in DashBoard as outlined in “**To access the NEWT-IPX interfaces in DashBoard**”.

2. Select **Advanced > Discovery**.

3. Locate the **RTSP** area in the tab.

4. Use the **Interface** menu to specify what physical port the NEWT-IPX uses for RTSP communications.

5. Use the **Port** field to specify the TCP port the protocol uses to send and receive messages.

6. Click **Apply** to save the new settings.

7. Click **Reboot** to apply the new settings. This button is located at the bottom of the interface. The NEWT-IPX is temporarily taken off-line during the reboot.

8. Monitor the reboot progress.
Ember+ Support
• NEWT-IPX implements BESS v1.1 for Ember+ support to communicate with third-party controllers.

Keep the following in mind when setting up an Ember+ connection with NEWT-IPX:
• Ensure that all network streams have a consistent audio channel count.
• Audio shuffling is not supported in Ember+ setups.
• NEWT-IPX supports one-to-many connections (where one source can be routed to multiple targets).

Video Signal Mapping for Ember+
Each Group in the Ember+ tree represents a different physical SDI interface on NEWT-IPX (Group 1 represents SDI 1, Group 2 represents SDI 2, etc.) The video SDI signal in the network stream is mapped to Video 1 in the Ember+ client.

Audio Channel Mapping for Ember+
There are 16 audio channels per SDI signal (and therefore 16 channels per group since each group represents an SDI signal). Channels in the network stream are mapped to the corresponding audio channels in the Ember+ client in a 1-to-1 mapping.

In each channel count mode, the Sender configuration must first be created in DashBoard to show up in the Ember+ tree. If a Sender has not been set up through DashBoard for one of these sets of channels then these Audio sub-groups will contain no SDP file. If a Sender is created without following the channel mapping configuration above, the Ember+ tree contents will not be correct.

16-channel Audio Count Mode
In 16-channel count mode, there is only one Audio sub-group (Audio 1) per Group. This is because each SDI/Group has 16 channels, so all channels are represented as a single sub-group of that SDI signal. (Figure 13)

In Figure 13, the Receivers > Group 1 > Audio 1 represents the receiver that maps to audio channels 1 to 16 of SDI 1; Receivers > Group 2 > Audio 1 represents the receiver that maps to audio channels of SDI 2. When connecting a 16-channel network stream to one of these targets, the 16 channels from the network stream will be mapped to the corresponding audio channels in a 1-to-1 mapping.

In Figure 13, the Transmitters > Group 1 > Audio 1 represents the sender that maps to audio channels 1 to 16 of SDI 1. The Transmitters > Group 1 > Video 1 group represents the video of the SDI signal.
8-channel Count Mode

If the channel count mode is set to 8, each SDI/Group includes 2 audio sub-groups (Audio 1-8 and Audio 9-16 respectively). The Video 1 sub-group represents the video of the SDI signal. (Figure 14)

Figure 14  Ember+ Tree Example — Channel Count Mode set to 8

In Figure 14, the Receivers > Group 1 > Audio 1 represents the receiver that maps to audio channels 1 to 8 for SDI 1; Receivers > Group 1 > Audio 2 represents the receiver that maps to audio channels 9 to 16 for SDI 1. When connecting an 8-channel network stream to one of these targets, the 8 channels from the network stream will be mapped to the corresponding audio channels in a 1-to-1 mapping.

In Figure 14, the Transmitters > Group 1 > Audio 1 represents the sender that maps to audio channels 1 to 8 for SDI 1; Audio 2 maps to the sender that maps to audio channels 9 to 16 for SDI 1; etc.

2-channel Count Mode

If channel count mode is set to 2, there are 8 audio sub-groups with 2 channels each per SDI/Group. The Video 1 sub-group represents the video of the SDI signal. (Figure 15)

Figure 15  Ember+ Tree Example — Channel Count Mode set to 2
In Figure 15, the Receivers > Group 1 > Audio 1 represents the receiver that maps to audio channels 1 and 2; Receivers > Group 1 > Audio 2 represents the receiver that maps to audio channels 3 and 4; etc. When connecting a 2-channel network stream to one of these targets, the 2 channels from the network stream will be mapped to the corresponding audio channels in a 1-to-1 mapping.

In Figure 15, the Transmitters > Group 1 > Audio 1 represents the sender that maps to audio channels 1 and 2; Audio 2 maps to the sender that maps to audio channels 3 and 4; etc.

1-channel Count Mode

If channel count mode is set to 1, there are 16 audio sub-groups (Audio 1-16) with 1 channel each. The Video 1 sub-group represents the video of the SDI signal. (Figure 16)

![Figure 16 Ember+ Tree Example — Channel Count Mode set to 1](image)

In Figure 16, the Receivers > Group 1 > Audio 1 represents the receiver that maps to audio channel 1 of SDI 1; Receivers > Group 1 > Audio 2 represents the receiver that maps to audio channel 2 of SDI 2; etc. The Video 1 group represents the video of the SDI signal.

In Figure 16, the Transmitters > Group 1 > Audio 1 represents the sender that maps to channel 1 of SDI 1; Audio 2 maps to the sender that maps to audio channel 2 of SDI 2; etc. The Video 1 group represents the video of the SDI signal.

Establishing a Connection

Before proceeding, ensure that SDP patching is enabled with the Ember+ client to establish audio receivers on the NEWT-IPX.

To establish a connection between the Ember+ client and the NEWT-IPX
1. Add the NEWT-IPX in the Ember+ client interface using the IP Address assigned to the NEWT-IPX.
2. In DashBoard:
   a. Navigate to NEWT-IPX Advanced > Discovery tab.
   b. Locate the Ember+ area in the tab.
   c. Set the Port field to 9095.
3. In the Ember+ client, set the TCP port to 9095 for the NEWT-IPX.
Specifying the Audio Channel Count Mode on the NEWT-IPX

By default, the Channel Count mode is set to 8 but this value can be edited in DashBoard.

🌟 You will need to reboot the NEWT-IPX before the Ember+ tree is updated with the new Channel Count mode.

To set the Audio Channel Count mode on the NEWT-IPX

1. In DashBoard, navigate to the Advanced > Device Setup tab.
2. Use the Audio Channel Count Mode menu to specify the number of channels in each group.
3. Click Apply.

Configuring the NEWT-IPX for Ember+

In Ember+ setup, you will need to create the Senders via DashBoard, and then use the Ember+ controller interface (e.g. Lawo VSM) to make connections to receivers. Refer to the documentation that came with your controller for details.

SLP Support

DashBoard uses the Service Location Protocol (SLP) to find devices in a local area network (LAN) without prior configuration. Enabling SLP on the NEWT-IPX allows it to announce its location on the local network, establish communications with DashBoard, and display its node in the Basic Tree View of DashBoard.

🌟 This protocol is enabled by default on the NEWT-IPX.

Walkabout Support

The Walkabout Device Configuration Tool provides basic network communication settings and helps DashBoard to identify devices for initial IP setup. The Walkabout software is available as part of DashBoard v6.2 or higher and as a free download from our website.

🌟 This protocol is enabled by default on the NEWT-IPX. Disabling this feature (by clearing the Advanced > Discovery > Walkabout Enable box) severs the connection with Walkabout, making the NEWT-IPX no longer discoverable by Walkabout.

For More Information on...

- using Walkabout to assign the IP Address to your NEWT-IPX, refer to “Using Walkabout to Assign the Initial IP Address to NEWT-IPX”.

SAP Support

This section outlines how to enable the NEWT-IPX to use the Session Announcement Protocol (SAP) when broadcasting multicast session information.

To configure the NEWT-IPX to use SAP for multicast broadcasting

1. Display the NEWT-IPX interfaces in DashBoard as outlined in “To access the NEWT-IPX interfaces in DashBoard”.
2. Select Advanced > Discovery.
3. Locate the SAP area in the tab.
4. Select the Enable box.
5. Click Apply to save the new settings.
6. Click Reboot to apply the new settings. This button is located at the bottom of the interface. The NEWT-IPX is temporarily taken off-line during the reboot.
7. Monitor the reboot progress.

NMOS Support

This section outlines the required settings on the NEWT-IPX to establish communications via the Network Media Open Specifications (NMOS).

To configure the NEWT-IPX as a NMOS device

1. Display the NEWT-IPX interfaces in DashBoard as outlined in “To access the NEWT-IPX interfaces in DashBoard”.
2. Select Advanced > Discovery.
3. Locate the NMOS area in the tab.
4. To assign a name to the NEWT-IPX for use in the NMOS network, perform one of the following:
   • Use the Device Name menu to specify a unique identifier for the NEWT-IPX in the NMOS network; or
   • Click Use System Device Name.
5. Use the Interface menu to specify what physical port the NEWT-IPX uses for NMOS communications.
6. Click Apply to save the new settings.
7. Click Reboot. This button is located on the bottom of the interface.
8. Monitor the reboot progress.

Enabling Source Specific Multicast Mode (SSM)

When SSM is enabled, the NEWT-IPX receiver will monitor traffic for a specific destination multicast address and receive traffic from only one specific source sending to that multicast address.

* SSM is supported for both redundant (SMPTE 2022-7) and non-redundant traffic.

Keep the following in mind when enabling SSM:
• The NEWT-IPX follows the IGMPv3 standard as defined in RFC3376.
• If the network switch is configured for IGMPv2, the NEWT-IPX will communicate via Any-Source Multicast (ASM) instead of SSM.
• While SSM allows a source address to be defined, a network switch will differentiate between the network streams coming from different sources and route them independently even if they share the same Destination Multicast address.
• Specify only one source address when subscribing to a multicast stream.
• All connection protocols in a SSM-enabled system will use SSM (e.g. NMOS, DashBoard, Ember+, JSON API).

To enable SSM on the NEWT-IPX

1. Display the NEWT-IPX interfaces in DashBoard as outlined in “To access the NEWT-IPX interfaces in DashBoard”.
2. Select Advanced > Device Setup.
3. Select the Enable Source Specific Multicast box.
4. Click Apply to save the new settings.

A Source IP field displays in the Advanced > Receivers and Network Streams tabs.
Configuring the Timing Settings

The NEWT-IPX supports the Precision Time Protocol (PTP) as defined in the IEEE 1588-2008 standard and the SMPTE ST 2059 specification.

Specifying a Reference Format Rate

NEWT-IPX requires a PTP master on the media network to drive its timing. By default, the NEWT-IPX is configured to run as a PTP slave. If there is no lock to PTP, the NEWT-IPX will not receive IP streams.

You can also change the System Frame Rate via the Advanced > Device Setup tab.

To specify a frame rate for the NEWT-IPX video signals
1. Display the NEWT-IPX interfaces in DashBoard as outlined in “To access the NEWT-IPX interfaces in DashBoard”.
2. Select the Initial Setup tab.
3. Use the System Frame Rate menu to specify a video frame rate that is compatible with the SDI signals that the NEWT-IPX will output.
4. Click Apply to save the new setting.
5. Click Reboot to apply the new setting.

The System Frame Rate setting will not be applied until the PTP is locked.

Configuring the PTP Settings

From the Timing tab in DashBoard, you can synchronize the NEWT-IPX to real-time clocks of other devices in the same network.

There are several criteria that PTP clocks compare to determine who will be master and who will be slave (called the Best Master Clock Algorithm, or BMCA), and they are evaluated in order: Priority1, clock class, accuracy, scaled log variance, Priority2, clock ID (similar to the MAC address). Practically, Priority1 is the only setting configured on all clocks to control the outcome of the Grandmaster election. If Priority1s are equal, the next criterion is evaluated (clock class) and the criteria are evaluated in succession until a Grandmaster is determined.

To update the PTP settings for the NEWT-IPX
1. Display the NEWT-IPX interfaces in DashBoard as outlined in “To access the NEWT-IPX interfaces in DashBoard”.
2. Select the Initial Setup tab.
3. You can also change these settings via the Advanced > Timing > PTP tab.
4. Locate the Configure PTP Timing System area of the Initial Setup tab.
4. Select the **Slave Only** box to define the NEWT-IPX as only a slave and never a Boundary Clock or Grandmaster device.

5. Select the **Custom PTP Profile** box.

6. Use the **Domain** field to specify the sub-domain the PTP clock is assigned to.

   ✴ There can be multiple PTP domains operating concurrently within a network. The domain is a field in all PTP message headers. Messaging between entities are segregated by domain (e.g. The NEWT-IPX is an endpoint configured for domain 128 and ignores messages from a neighboring clock configured for domain 127).

7. If you did not select the **Slave Only** box and the NEWT-IPX matches the primary Grandmaster election criterion for your network:
   a. Use the **Priority 1** field to define the first 8bit clock field.
   b. Use the **Priority 2** field to define the backup 8bit clock field.

**To configure the PTP settings for a specific NET port**

1. Select **Advanced > Timing**.

   The **PTP** tab is automatically selected.

   ![PTP tab](image)

2. Select the **Custom PTP Profile** check box.

   The Domain, Priority1, Priority2, Sync Interval, Announce Interval and Announce Receipt Timeout fields are now editable.

   ✴ The **Custom PTP Profile** can also be set using the Initial Setup tab.

3. Use the **Sync Interval** field to specify the number of seconds at which synchronization messages are sent from the master clock to the specified NET port on the NEWT-IPX.

4. Use the **Announce Interval** field to specify the rate of announce messages that the specified NET port on the NEWT-IPX requests from the master clock during a unicast session.

5. Use the **Announce Receipt Timeout** field to specify the number of seconds the specified NET port on the NEWT-IPX waits for an announce interval message before timing out.

6. Click **Apply** to save the new settings.
Configuring the Video Delay and Audio Offset for Outputs

An output is timed relative to the input stream, and the source will be delayed a fixed offset from the sender’s RTP timestamps. This allows for non-PTP aligned sources to be passed through with fixed latency.

🌟 Use this procedure if you need to adjust the timing of each output independently. Otherwise it is recommended to keep these settings at the default values.

**To adjust the timing for an output**

1. Display the NEWT-IPX interfaces in DashBoard as outlined in “To access the NEWT-IPX interfaces in DashBoard”.
2. Select Advanced > Timing.
3. Click Outputs.
   
   The Timing tab updates to display the timing options for each output. In the following example, there are four SDI outputs available for adjustment.

🌟 The number and type of available outputs depends on the Operational Mode the NEWT-IPX is set to. Refer to “Specifying an Operational Mode” for details.

4. Locate the options for the output you want to adjust the timing for.
5. To automatically apply the default video delay value 2000us when in 125us packet time and 16000us when in 1ms, select the Default Delay box for the output. The default audio offset is 0.
6. To manually configure the delay and offset values for an output:
   a. Verify that the Default Delay box is cleared.
   b. Use the Video Delay slider to adjust the relative position of the video output start of frame as an offset to the reference.

🌟 You cannot edit the video delay when in UHD-over-IP to HDMI 2.0 Gateway mode.
   c. Use the Audio Offset slider to adjust the relative position of the audio start position as an offset to the reference.

🌟 Audio delay is specified relative to the video timing.
7. Click Apply to save the new settings.
8. Refresh the connection.
To re-establish connections, proceed to “Operation”.

Setting the Audio Packet Time

You can add an offset to the audio streams if you wish to define the rate that the NEWT-IPX sends packets. Keep in mind that a smaller packet time results in more Ethernet packet overhead (more packets are sent) but less network delay.

This impacts all connected audio streams. Applying a new Audio Packet Time automatically disconnects and re-connects all audio streams. It is recommended to set the Audio Packet Time before configuring your audio streams.

To set the audio packet time

1. Display the NEWT-IPX interfaces in DashBoard as outlined in “To access the NEWT-IPX interfaces in DashBoard”.
2. Select the Advanced > Device Setup.
3. Use the Audio Packet Time menu to specify the amount of time that NEWT-IPX will add as an offset to the audio streams.
4. Click Apply.
5. Verify that the audio streams have re-connected by viewing their status:
   a. Select the Connections tab.
   b. Locate the audio streams row in the Destinations area of the tab.
   c. Verify the read-only fields display “Connection was Successful”.
   d. If the audio streams do not automatically connect, navigate to the Receivers tab and verify the settings for the audio streams.
Configuring the Receivers

A receiver on the NEWT-IPX can be configured to connect to a network stream with any destination multicast IP address in the range of 225.x.x.x and 239.x.x.x.

For More Information on...
• specifying the network stream groups, refer to “Setting up the Network Streams”.
• the assigning of a Receiver to a Stream, refer to “Operation”.

Configuring a Receiver

Each configured Receiver can be monitored on the NEWT-IPX using the fields in the Receivers tab. You can also choose to disconnect a stream (connected outside of DashBoard) from the Receivers tab.

* The number and type of available outputs depends on the Operational Mode the NEWT-IPX is set to. Refer to “Specifying an Operational Mode” for details.

To name a receiver
1. Display the NEWT-IPX interfaces in DashBoard as outlined in “To access the NEWT-IPX interfaces in DashBoard”.
2. Select Advanced > Receivers.
3. Locate the row for the SDI signal you wish to configure.
4. Use the Name field to specify a unique identifier for the receiver.

* This identifier is used to help identify the receiver within your system and in the DashBoard Connections interface.

To verify the protection switching feature
1. Ensure the ST 2022-7/Seamless Protection Switching box is selected as outlined in “Enabling the Protection Switching Feature”.
2. Select Advanced > Receivers.
3. Locate the row for the SDI signal you wish to configure for protection switching.
4. Click to expand the options.
The Protection Switching options display as two separate rows under the SDI.

Protection switching streams are assigned when a connection is made in the Connections tab. Refer to “Routing the Signals” for more information.

A Source IP field also displays if SSM is enabled on the NEWT-IPX. Refer to “Enabling Source Specific Multicast Mode (SSM)” for details.

Assigning a Test Pattern to the SDI Output

You can specify the type of internally generated test pattern to output.

The number of SDI outputs available depends on the Operational Mode. Refer to “Specifying an Operational Mode” for details.

To assign a test pattern to an SDI output

1. Display the NEWT-IPX interfaces in DashBoard as outlined in “To access the NEWT-IPX interfaces in DashBoard”.
2. Select Advanced > PattGen.
3. Locate the row for the SDI signal you wish to output a test pattern on.
4. Use the Format menu to specify the video format for the test pattern output.
5. Use the Pattern menu to specify the pattern to display on the output.
6. Select the Enable box to allow the SDI connection to output the test pattern.
7. Click Apply to save the new settings.

Using the Disconnect Button

Clicking the Disconnect button for a session immediately stops that session and outputs black. This is helpful:

- to free up NET bandwidth
- if the source is invalid or missing
- if the source includes data that you do not want to output
- to update the receiver with the latest NET settings

You will need to return to the Connections tab to reconnect the sessions.
Configuring the Senders

This chapter provides instructions for configuring the sender channels on the NEWT-IPX when it is configured as an 2-in/2-out SDI/IP Converter.

Before You Begin

Keep the following in mind:

• The NEWT-IPX must be configured as an 2-in/2-out SDI/IP Converter. Refer to “Installing a License Key” and “Specifying an Operational Mode” for details.

• A sender stream on the NEWT-IPX can be configured with any destination multicast IP address in the range of 225.x.x.x and 239.x.x.x.

• For each SDI input signal, you need to specify the IP encapsulation properties for the active video and audio.

• The NEWT-IPX supports Automatic Sender SDP updates. Refer to “Automatic Sender Session Description Protocol (SDP) Updates” for details.

Configuring the Active Video Properties

Before you begin, make a note of the NET Bandwidth Allocation for the NET ports to determine the available capacity on each port. This information is displayed in the top portion of the Senders tab.

To configure the active video properties for a sender stream

1. Display the NEWT-IPX interfaces in DashBoard as outlined in “To access the NEWT-IPX interfaces in DashBoard”.
2. Select Advanced > Senders > Setup Streams.
3. Click Add Stream.
   The Stream list and Source Name field updates to include a new entry “Sender: #” where # is an auto-generated number.
4. Use the Source Type menu to select Video.
5. Use the **Source Name** field to assign a unique identifier for the stream.

The **Source Name** is used to help identify the sender within your system and in the DashBoard Connections interface.

6. Edit the **Transport IP** and **UDP Port** fields for the Primary Stream you wish to assign the sender to.

When the Auto Generate Sender Multicast feature is enabled, entering a value of 0.0.0.0 in the **Transport IP** and **UDP Port** fields will allow the advertised stream to auto-populate the fields.

7. If required, edit the **Transport IP** and **UDP Port** fields for the Protection Switching stream the sender will use.

8. Use the **Select Video Source** menu to assign the SDI input signal to the sender stream.

9. Click **Apply** to save the new settings.

### Configuring the Active Audio Properties

Before you begin, make a note of the **NET Bandwidth Allocation** for the NET ports to determine the available capacity on each port. This information is displayed in the top portion of the **Senders** tab.

### Creating an Audio Stream Group

You can map the audio channels to a stream as required: using the default map of 1:1 or selecting specific channels and assigning them in any given order. This enables you to customize each audio stream group to include any available audio channels.

**To configure the active audio properties for a sender stream**

1. Display the NEWT-IPX interfaces in DashBoard as outlined in “To access the NEWT-IPX interfaces in DashBoard”.
2. Select **Advanced** > **Senders** > **Setup Streams**.
3. Click **Add Stream**.
4. Use the **Source Type** menu to select **Audio**.

5. Use the **Source Name** field to assign a unique identifier for the stream.
This identifier is used to help identify the sender within your system and in the DashBoard Connections interface.

6. Edit the Transport ID and UDP Port fields for the Primary Stream you wish to assign the sender to.

It is recommended to not edit the Transport ID and UDP Port fields as these fields are auto-populated by the advertised stream.

7. If required, edit the Transport ID and UDP Port fields for the Protection Switching stream the sender will use.

8. If you need to map the audio channels to this new stream, proceed to “Mapping the Audio Channels to a Sender Stream”.

9. Click Apply to save the new settings.

Mapping the Audio Channels to a Sender Stream

You can choose to apply the default audio channel map or assign the channels as required by your system. Both methods are described below.

To map the audio channels to a sender stream using the default channel map

1. Create a new audio stream as outlined in “Creating an Audio Stream Group”.

2. Click Set Default Audio.

   The SDI Channels map updates to display the default channel options.

3. Click Apply to save the new settings.

To customize the audio channel mapping for a sender stream

1. In the SDI Channels map, select the channels to include in the audio stream.

   In the example below, the user selected channel B7.

2. In the Target map, select the sender channel to assign the audio channel to.

   In the example below, the user selected Target channel 2.

3. Click .

4. Click Apply to save the new settings.
Setting up the Network Streams

Once you have the Receivers configured on the NEWT-IPX, you must specify the available IP streams as network sessions for the NEWT-IPX.

Overview

You can configure a network stream for the NEWT-IPX by assigning an advertised stream or adding a stream by manually specifying the IP stream credentials.

Advertised Streams

A network stream advertised by a node flows to multiple devices. The list of advertised RAVENNA streams available to the NEWT-IPX depends on the following settings:

- Advanced > Timing > PTP
- Advanced > Device Setup > Transport Options

Manually Assigning a Stream

An IP stream can also be manually assigned as a network stream for the NEWT-IPX. You will need the Transport IP Address, Port number, and DSCP value for the IP stream you want to add. This is useful if you wish to access a network stream that is not a RAVENNA device.

Adding a Network Stream

A network stream is identified in the Receivers and Connections tabs using the parameters specified in the Network Streams tab. Ensure to give each network session a unique name for easy identification in the DashBoard interfaces.

To add a new network stream using an advertised stream

1. Display the NEWT-IPX interfaces in DashBoard as outlined in “To access the NEWT-IPX interfaces in DashBoard”.
2. Select the Network Streams tab.
3. Click **Add Group**.
   The fields in the **Network Streams** tab clear and the **Group Name** field displays “NewGroup#” where # is an auto-generated character.

4. Use the **Group Name** field to specify a unique identifier for the network stream.

5. Use the options in the **Group Category** area to assign the network stream to a Connections category.

6. Use the **# Audio Streams** box to specify the total number of audio streams for this group.

7. Verify that the **Assign Manually** box is unselected (cleared).

8. Use the **Advertised Network Streams** menus to specify the stream for the video and/or audio signals for the network stream.

   - **Format**, **Transport IP**, **Port**, **UDP Port**, and **# Ch** fields are read-only and automatically populated when a new selection is made in the **Advertised Network Streams** area.

   - A **Source IP** field also displays if SSM is enabled on the NEWT-IPX. Refer to “Enabling Source Specific Multicast Mode (SSM)” for details.

9. Click **Save** to update the list in the Network Streams tab.

**To add a new network stream using a manually added stream**

1. Display the NEWT-IPX interfaces in DashBoard as outlined in “**To access the NEWT-IPX interfaces in Dashboard**”.

2. Select the **Network Streams** tab.

3. Click **Add Group**.

   The fields in the **Network Streams** tab clear and the **Group Name** field displays “NewGroup#” where # is an auto-generated character.

4. Use the **Group Name** field to specify a unique identifier for the network session.

5. Use the options in the **Group Category** area to assign the network stream to a Connections category.

6. Select the **Assign Manually** box.

   The **Format**, **Transport IP**, **UDP Port**, and **# Ch** fields are now editable.

7. Use the **Format** field to specify the video format of the signal available for the stream.

8. Use the **Transport IP** field to specify the Multicast IP Address for the network session.

   - Only multicast IP Address in the range of 225.x.x.x to 239.x.x.x can be received by the NEWT-IPX. Contact Ross Technical Support if you need additional IP ranges.

9. Use the **UDP Port** field to specify the RTP port for the advertised stream.

10. Use the **# Ch** field to specify the maximum number of audio channels in the specified stream.

11. Click **Save** to update the list in the Network Streams tab.

**To specify network streams for protection switching**

1. Ensure the **ST 2022-7/Seamless Protection Switching** box is selected as outlined in “**Enabling the Protection Switching Feature**”.

2. Add a new network stream as outlined in “**To add a new network stream using a manually added stream**”.

   - The **Protection Switching** options display as two separate rows.

3. Use the **Protection Switching** fields to assign the redundant video and audio streams to the NEWT-IPX.
4. Click **Save** to update the list in the Network Streams tab.

### Mapping the Audio Channels

You can choose to apply the default audio channel map or assign the channels as required by your system. Both methods are described below.

**To assign audio channels to a stream using the default map**

1. Locate the **Audio Map** area of the **Network Streams** tab.
2. Select the **Default Mapping** box to map the channels to audio streams as 1:1.
   
   In the example below, the **# Audio Streams** was set to **8**.

   ![Audio Map Example]

3. Click **Save** to update the list in the Network Streams tab.
   
   You may need to scroll down the tab to locate this button.

**To customize the audio channel mapping for the network stream**

1. Locate the **Audio Map** area of the **Network Streams** tab.
   
   You may need to scroll down the tab to fully display the **Audio Map**.
2. Clear the **Default Mapping** box.

   The Channel Mapping area updates to display the mapping options based on the number of destinations and audio channels you specified using the fields on this tab.

   The **Edit** button now displays.
3. Click **Edit**.

   The Audio Map area updates to provide two maps.

4. Select the network stream channel(s) on the leftmost map.
   
   You can also select multiple stream channels by clicking and dragging the audio channels.

   The following example, the user selected **B1**.

   ![Audio Map Example]
5. On the rightmost map, select the output channel(s).
   The following example, the user selected **A4**.

   ![Audio Map](image)

6. Click **** to assign the channel.
   The label of the Target button selected in step 5 updates to display the assigned channel (**B1**).

   ![Audio Map](image)

7. Repeat steps 4 to 6 to map all the channels to target channels.
8. Click **Save**.
Operation

You can route the NEWT-IPX destinations and stream groups using the options in the Connections tab.

Connections Tab Overview

The Connections tab is organized into two areas: Destinations (top) and Stream Sources (bottom).

![Figure 17 Example of a Populated Connections Tab — IP to 4x3G-SDI Gateway Mode](image1)

![Figure 18 Example of a Populated Connections Tab — UHD-over-IP to HDMI 2.0 Gateway Mode](image2)
1. Destinations Area

This area displays the available outputs in a series of rows. Each output is represented as a button which is clicked to include it in the routing switch. Video and Audio read-only fields report the Network Streams assigned to the output.

A Status read-only field reports overall communication status and whether any error conditions are occurring on the SDI or HDMI output.

* When operating in HDMI Quad-Split mode, the outputs are labeled as “QUAD” and AUDIO with each QUAD representing the output for a specific quadrant and the AUDIO as the assigned audio stream for the HDMI output. Refer to “HDMI Quad-Split Mode” for details.

2. Stream Sources Area

This area displays the available inputs as selectable buttons. Use the Filter field, the Show options, or the Stream Sources buttons, to narrow down the options displayed in the area.

Routing the Signals

To route the video and audio signals you must first select an SDI or HDMI output (depending on the Operational Mode), then a network stream. Keep in mind that routing occurs automatically after a Stream button is selected.

* The number of SDI outputs available depends on the Operational Mode. Refer to “Specifying an Operational Mode” for details.

To select an output

1. Display the NEWT-IPX interfaces in DashBoard as outlined in “To access the NEWT-IPX interfaces in DashBoard”.
2. Select the Connections tab.
3. In the Output Name row of the Destinations area, locate the button for the output you wish to route.
4. Click the required **Output** button.

**To perform the switch**

1. In the **Stream Groups** area, locate the button for the input (Network Stream) you wish to route.

![Routing Selection](image)

The associated **Video** and **Audio** fields report the video and audio signals of the selected Network Stream.

2. Click the required **Network Stream** button to perform the switch.

**Performing a Breakaway**

A breakaway selects a specific receiver group to be switched. This allows a Receiver to route video from one network stream, and audio from another network stream.

**To set up a breakaway**

1. Display the NEWT-IPX interfaces in DashBoard as outlined in “**To access the NEWT-IPX interfaces in DashBoard**”.

2. Select the **Connections** tab.

3. Select the video to switch as follows:
   a. In the **Destinations** area, select the video field of the interface you wish to include.
   b. In the **Stream Groups** area, select the stream group you wish to route for video for this switch.

4. Select the audio to switch as follows:
   a. In the **Destinations** area, select the audio field of the interface you wish to include.
   b. In the **Stream Groups** area, select the stream group you wish to route for audio for this switch.

*If video is selected for a particular interface in the Destinations area and the selected Stream Group has a video stream, a video receiver is created on the destination. If audio is selected for a particular interface in the Destinations area and the selected Stream Group has an audio stream, an audio receiver is created on the destination.*

**Automatic Sender Session Description Protocol (SDP) Updates**

When the NEWT-IPX is in 2-in/2-out SDI/IP Converter mode and a sender stream is already active and the video format changes on the SDI input of that stream, the sender stream SDP will
automatically update and start sending the new video format. The Session and NMOS IDs do not change when the sender stream SDP update is performed and new streams do not need to be created using the new video format. This allows the existing streams to adapt so that the controller does not need to track new streams. This feature is always enabled and cannot be disabled.

This feature is helpful when changing the video format in the following scenarios.

Quick Updates when Streaming from the NEWT-IPX

When the format of the SDI input video changes, the NEWT-IPX automatically updates its sender stream and the SDP file, to advertise the new format with no user intervention required. The ST 2110 stream and SDP file are also updated and the video sender resumes with the new format within 5 seconds. The user then reconnects the receiver sessions to switch to the updated video format.

Protection from Invalid Video Scenarios

If a glitch, loss of signal, or SDI video format change of less than 0.5 seconds occurs, the automatic SDP update will not occur. In addition, when an SDI input with a non-matching frame rate is detected, an alarm in DashBoard is raised. The SDP file remains unchanged, and the sender continues to transmit. This prevents the entire system from switching to an invalid video format or unstable video input.

Using any Supported Control Protocol

The advertised SDP file updates to reflect a valid video format change through all supported control protocols, including NMOS, Ember+, and DashBoard advertised network streams. This enables any controller to use the new SDP file, and enables the user to update the connections of any active receivers to the new format without having to recreate the sender streams.
SQLD Setup

There are two different ways of performing a quad link: Square Division Quad Split and 2 Sample Interleave. This chapter provides information on the SQD feature of the NEWT-IPX.

* This chapter assumes that you have configured the Ethernet and timing settings, as well as receivers/senders for your NEWT-IPX.

What is Square Division Quad Split (SQD)?

SQD is a Quad Link method introduced to produce a UHD image. Each stream contains one quarter of the original image. (Figure 20) Each quarter image is displayed at HD 1920x1080 resolution, and then quadrants are reassembled to create a full UHD image.

![Figure 20 Representation of SQD Sampling](image)

How does SQD differ from 2 Sample Interleave (2SI)?

In 2SI, the entire image is interleaved across the four streams, so each stream looks like a lower-resolution version of the original image. The four streams are then combined to create one 3840x2160 image.

Features

The SQD feature of NEWT-IPX provides the following:

- Receive up to 4 streams of SMPTE ST 2110-20 video simultaneously
- Support for 4x1080p UHD support for HDMI 2.0 video (2160p25, 29.97, 30, 50, 59.94, and 60)
- Coherence check for 4 quadrant streams to be present and contain the same format
- All four quadrants are aligned using RTP timestamps
- Redundancy support for 2160p 50Hz and lower
- Support for JSON API, Ember+, and DashBoard

Setup Overview

1. Enable the NEWT-IPR-UHD-H license. Refer to “Installing a License Key”.
2. Set the Operating Mode to UHD-over-IP to HDMI 2.0 Gateway. Refer to “Specifying an Operational Mode”.
3. Make an SQD video stream available to the NEWT-IPX.
4. Manually add the SQD video stream to the NEWT-IPX.
5. Connect the SQD video stream to an output (destination) on the NEWT-IPX.

Configuring the HDMI Output

After enabling the NEWT-IPR-UHD-H license, you need to connect to the video stream that will be routed to the HDMI output. The video format will be specified when you connect to the stream.

To specify the video format of the HDMI output
1. Ensure the network stream for the HDMI output is not running when you enable the HDMI Pattern Generator.
2. Select Advanced > PattGen.
3. Select the Enable box for HDMI 1.
4. Use the Format menu to specify the video format of the HDMI output.
5. Click Apply at the bottom of the Device Setup tab.

Adding an SQD Video Stream to the NEWT-IPX

You will need to manually add the SQD video stream to the list of available network stream groups that the NEWT-IPX can access.

To connect an SQD video stream to the NEWT-IPX
1. Display the NEWT-IPX interfaces in DashBoard as outlined in “To access the NEWT-IPX interfaces in DashBoard”.
2. Select Network Streams.
3. Click Add Group.
   a. The fields in the Network Streams tab clear and the Group Name field displays “NewGroup#” where # is an auto-generated character.
4. Use the Group Name field to specify a unique identifier for the SQD video stream.
5. Use the Format field to specify the video format of the SQD video stream.
6. Select Video in the Group Category area.
7. Select the Assign Manually box.
8. For each quadrant of the SQD stream, use the Transport IP field to specify the Multicast IP Address for the quadrant.

† Only multicast IP Addresses in the range of 225.x.x.x to 239.x.x.x can be received by the NEWT-IPX. Contact Ross Technical Support if you need additional IP ranges.
   a. Use the UDP Port field to specify the RTP port for the quadrant.
   b. Use the # Ch field to specify 1.

The example below shows a configured “SQD” network stream group.
9. Click **Save** to update the list in the Network Streams tab.

**Connecting the SQD Video Stream to an Output on the NEWT-IPX**

Once an SQD video stream is connected to the NEWT-IPX, you can route it to the HDMI output of the NEWT-IPX.

**To route the SQD video stream to the HDMI output on the NEWT-IPX**

1. Display the NEWT-IPX interfaces in DashBoard as outlined in “**To access the NEWT-IPX interfaces in DashBoard**”.

2. Select **Connections**.

3. Click the **HDMI 1** output button.

4. In the Stream Sources area, select the SQD video stream group configured in “**To connect an SQD video stream to the NEWT-IPX**”.

   In the example below, the user selected the **SQD** network stream button.
HDMI Quad-Split Mode

This chapter provides information on configuring the HDMI Quad-Split mode of the NEWT-IPX.

What is Quad Split?

The Quad Split feature allows you to view four streams from a single output of an NEWT-IPX. Any configured network stream can be assigned to any quadrant of the NEWT-IPX HDMI output.

Features

The Quad-Split feature of NEWT-IPX provides the following:
- Support for SMPTE ST 2110-20 video (1080p 50Hz and 1080p 59.94Hz)
- Support for HDMI 2.0 video (2160p 50Hz and 2160p 59.94Hz)
- Redundancy support for 2160p 50Hz
- Support for black quadrants
- Supports the One-to-Many feature
- Support for JSON API
- Ability to monitor 8-channels of audio via the HDMI interface with the Quad Split video

Overview

The HDMI Quad-Split feature enables you to assign a network stream to each quadrant,

You can assign a different network stream to each quadrant and AUDIO output.

Disconnected quadrants are “empty”

Or, you can assign the same network stream to multiple quadrants (Figure 23)
Configuration Overview
1. Enable the NEWT-IPR-UHD-H license. Refer to “Installing a License Key”.
2. Set the Operating Mode to UHD-over-IP to HDMI 2.0 Gateway. Refer to “Specifying an Operational Mode”.
3. Enable Quad Split mode as outlined in “To enable HDMI Quad-Split Mode”.
4. Use the Network Streams tab to create network streams.
5. Use the Connections tab to select between Video-only network streams, Audio-only network streams, or Video and Audio network streams.
6. Use the Connections tab to connect video source streams to the QUAD destinations.
7. Use the Connections tab to connect audio source streams to the AUDIO output.

Enabling HDMI Quad-Split Mode
When the HDMI Quad-Split mode is enabled on the NEWT-IPX, the following tabs are updated:
- Connections — The Routing Selection area now displays options for assigning streams to QUAD 1-4 and an AUDIO output (any 8-channels of network audio).
- Advanced > Receivers > Status — Each row represents a QUAD with a row for the AUDIO.
- Advanced > Alarms — The Destination Streams are now labeled QUAD 1-4, and AUDIO.

To enable HDMI Quad-Split Mode
1. Display the NEWT-IPX interfaces in DashBoard as outlined in “To access the NEWT-IPX interfaces in DashBoard”.
2. Select Advanced > Device Setup.
3. Select the HDMI Quad-Split Mode box.
The **Apply Change** dialog opens.

4. Click **OK** in the **Apply Change** dialog.

5. Click **Apply** at the bottom of the **Device Setup** tab.

6. Click **Reboot** to save the new setting.

**To configure the HDMI output**

1. Ensure the network stream for the output is not running when you enable the HDMI Pattern Generator.

2. Select **Advanced > PattGen**.

3. Select the **Enable** box for **HDMI 1**.

4. Use the **Format** menu to specify the video format of the HDMI output.

5. Click **Apply** at the bottom of the **Device Setup** tab.

**Synchronize to PTP**

The NEWT-IPX requires a PTP master on the media network to drive its timing. By default, the NEWT-IPX is configured to run as a PTP slave. If there is no lock to PTP, the NEWT-IPX will not receive IP streams.

**To synchronize to a PTP master**

- Synchronize the NEWT-IPX to a real-time PTP clock in the same network. Refer to “Configuring the PTP Settings”.

**Configuring the Receivers**

Configure a Receiver for each QUAD and the AUDIO output. The procedure for configuring a QUAD output is the same as when not operating in HDMI Quad-Split mode. Note that the outputs are labeled as “QUAD” and “AUDIO” respectively when in HDMI Quad-Split mode.

**For More Information on...**

- receivers, refer to “Configuring a Receiver”.
Configuring the Network Streams

Next you will need to define each network stream that will be assigned to a QUAD Output (1-4) and the Audio output. This requires the same steps when not operating in HDMI Quad-Split mode. Note that the outputs are labeled as “QUAD” and “AUDIO” respectively.

Wifi When in Quad-Split mode, your network streams will all be either 1080p 59.94Hz or 1080p 50Hz.

For More Information on...

• configuring network streams, refer to “Setting up the Network Streams”.

Assigning a Stream to a QUAD Output

To route the video and audio signal you must first select a QUAD output, then a network stream.

Wifi Routing occurs automatically after a Stream button is selected.

To assign a network stream to a QUAD output

1. Display the NEWT-IPX interfaces in DashBoard as outlined in “To access the NEWT-IPX interfaces in DashBoard”.
2. Select the Connections tab.
3. In the Output Name row of the Destinations area, locate the button for the destination (QUAD 1-4, AUDIO) you wish to route.
4. Click the required Output button.

In the example below, the user clicked Destination 1 (QUAD 1).

5. In the Stream Groups area, locate the button for the input (Network Stream) you wish to route to the selected
6. Click the required Network Stream button to perform the switch.

In the example below, the user clicked Server012.
7. Repeat steps 3 to 6 for the remaining outputs.

Troubleshooting

This section offers tips for troubleshooting the HDMI Quad-Split mode.

A quadrant displays black pixels

The NEWT-IPX maybe ingesting video that is not 1080p 50Hz or 1080p 59.94Hz for that QUAD output.

A message displays warning that video must be initialized to send audio

The NEWT-IPX is currently connected to an audio stream only. No video streams were available when the crosspoint switch was made. Verify that the QUAD output experiencing the error is connected to a valid network stream that includes a video signal.

A message displays warning that only part of a network stream was connected

The NEWT-IPX is connecting network stream with both video and audio to a single destination.
Monitoring

The status of the NEWT-IPX may be monitored via the fields in the DashBoard client software.

* All alarms are enabled by default.

Monitoring the Streams

The Receivers tab reports read-only status information for each SDI signal. You can disable or enable the monitoring of specific SDI streams using the options in the Alarm Enable tab.

To monitor a specific receiver stream

1. Display the NEWT-IPX interfaces in DashBoard as outlined in “To access the NEWT-IPX interfaces in DashBoard”.
2. Select Advanced > Receivers.
3. Locate the row for the SDI signal you wish to monitor.
4. Click the button in the required row to display the video and audio status fields for an SDI signal.

In the example below, SDI 1 was selected.

Notes on Monitoring the Receiver Streams

This section briefly summarizes the NEWT-IPX behavior when monitoring a receiver stream.

Receiver is configured to receive a stream, but the stream is absent

When a stream is absent (i.e. never detected, or was lost for an extended period of time), the NEWT-IPX does not output any SDI frames and the SDI link will be inactive.

If a stream was present, but is no longer, the receiver will be in a state of “frame replay” where the NEWT-IPX continuously outputs the last frame received. This will continue until either the stream resumes (in which case, the valid video will start playing again), or the receiver is disconnected. If the stream is disconnected, the NEWT-IPX will stop outputting data.
Receiver is not properly configured
The NEWT-IPX will not output data before a receiver is configured (e.g. start-up condition).

Tab is locked and displays an overlay message
The NEWT-IPX lost connection to the PTP Clock and is attempting to re-connect. Once the NEWT-IPX can lock to the PTP Clock, the tab is unlocked. The following tabs are not locked during a loss of PTP clock connection:
• Status
• Ethernet I/O
• Timing
• Setup

Monitoring the Video Streams
DashBoard reports the following diagnostic information for each video stream:
• the video frame buffer fill level over time
• the pixel buffer fill level over time
• counters for missing packets, invalid packets, frame drops and frame replays
• memory (read/write) statistics
• current RTP timestamp alignment errors
• stream interrupts (such as pending missing markers and/or frame drops)

You can also specify what information to monitor for each stream and specify which stream(s) to monitor:
• any connected video stream can be monitored
• primary and redundant stream information is monitored individually

To view the video output statistics
1. Display the NEWT-IPX in DashBoard as outlined in “To access the NEWT-IPX interfaces in DashBoard”.
2. Selected Advanced > Diagnostics.
3. Locate the Video Output Stream Diagnostics area.
4. From the Interface Select menu, specify the output you wish to monitor.
5. From the Stream Select menu, specify which network stream to monitor.

The Video Output Stream Diagnostics area updates to report information on the specified output and network stream. In the example below, the user selected SDI 3 for the output and Primary for the network stream.
6. To view the frame buffer levels or the pixel FIFO levels, scroll to the bottom of the tab.

Monitoring the Ethernet Status

DashBoard provides an estimate of the actual bandwidth of the Ethernet links:
- all packets received on the Ethernet links (media and processor traffic)
- transmit bandwidth (packets sent from the processor to the Ethernet links)
- receive bandwidth (packets sent on the link and forward to the processor)

DashBoard also provides counters for the receive errors, transmit errors, packet size ranges, and general bytes

To view the network diagnostic statistics
1. Display the NEWT-IPX interfaces in DashBoard as outlined in “To access the NEWT-IPX interfaces in DashBoard”.
2. Selected Advanced > Diagnostics.
3. Click Show Network Diagnostics > OK.
### Advanced Settings and Status

#### Network Diagnostics

<table>
<thead>
<tr>
<th>Link Statistics</th>
<th>N1</th>
<th>N2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rx Errors</td>
<td>315</td>
<td>425</td>
</tr>
<tr>
<td>Rx Frames</td>
<td>5</td>
<td>2</td>
</tr>
<tr>
<td>Rx Bandwidth</td>
<td>13,723 Mbs</td>
<td>13,716 Mbs</td>
</tr>
<tr>
<td>Tx Frames</td>
<td>1,837 Mbs</td>
<td>1,837 Mbs</td>
</tr>
<tr>
<td>Tx Bandwidth</td>
<td>651,100 kbs</td>
<td>650,100 kbs</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>CPU Statistics</th>
<th>N1</th>
<th>N2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rx Errors</td>
<td>2</td>
<td>2</td>
</tr>
<tr>
<td>Tx Frames</td>
<td>2</td>
<td>2</td>
</tr>
<tr>
<td>Rx Bandwidth</td>
<td>23.717 kbs</td>
<td>23.717 kbs</td>
</tr>
<tr>
<td>Tx Bandwidth</td>
<td>651,100 kbs</td>
<td>651,100 kbs</td>
</tr>
</tbody>
</table>

#### Video Output Stream Diagnostics

<table>
<thead>
<tr>
<th>Monitor Select</th>
<th>None</th>
</tr>
</thead>
</table>
Upgrading the Software

The NEWT-IPX software can be upgraded in the field using the CONTROL port and the options available in DashBoard.

★ Refer to the NEWT-IPX Software Upgrade Guide if you are upgrading your NEWT-IPX from a version prior to v.2.20.0.

To upgrade the software on the NEWT-IPX
2. Display the NEWT-IPX interfaces in DashBoard as outlined in “To access the NEWT-IPX interfaces in DashBoard”.
3. Select Upload, located near the bottom of the DashBoard interface, to display the Select file Upload dialog.
4. Navigate to the file you want to upload.
5. Click Open > Finish.
6. Monitor the upgrade.

★ Clicking Cancel or No returns you to the Uploading to Selected Devices dialog without rebooting the device(s).
  - Each NEWT-IPX device is temporarily taken off-line during the reboot process.
  - The process is complete once the status indicators for the Card state and Connection fields in the Status tab return to their previous status.

★ If the NEWT-IPX fails to upgrade correctly, contact Ross Technical Support for an upgrade file and instructions on using the Micro SD Card slot.
DashBoard Interface Overview

The NEWT-IPX groups the configuration, monitoring, and operating features as a series of tabs in the DashBoard client window.

Welcome Tab

The Welcome tab displays on initial start-up of the NEWT-IPX in DashBoard. Once the initial settings are configured and applied to the NEWT-IPX, you can hide the Welcome and Initial Setup tabs by selecting the required box on the Advanced > Device Setup tab and then clicking Refresh.

![Figure 24  Example of the NEWT-IPX Tabs in a DashBoard Window](image)

Initial Setup Tab

The Initial Setup tab helps you to quickly set up your NEWT-IPX and proceed to configuring your Network Streams and Connections. Help buttons provide additional information on the menus.

* These controls are also available in the Advanced tabs. Refer to “Advanced Tabs”.

![Figure 25  Example of the Initial Setup Tab](image)
Connections Tab

The Connections tab is a patch-panel style interface that enables the NEWT-IPX to connect to available senders on the network.

Destinations Area

The Destinations area is located at the top of the Connections tab and provides options for routing video and audio signals to the outputs on the NEWT-IPX. From this area you can quickly select outputs and monitor the status of the output signals.

![Example of a Destinations Area](image)

**Figure 26** Connections Tab — Example of a Destinations Area

![Example of a Destinations Area with Quad Split Enabled](image)

**Figure 27** Connections Tab — Example of a Destinations Area with Quad Split Enabled

Table 5 summarizes the buttons, menus, and fields available in the Destinations area of the Connections tab.

<table>
<thead>
<tr>
<th>Item</th>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Interface</td>
<td>#</td>
<td>Indicates the physical connection on the NEWT-IPX</td>
</tr>
<tr>
<td>Output Name</td>
<td>#</td>
<td>Each button represents an output that is configured and available for switching</td>
</tr>
<tr>
<td>Video (read-only)</td>
<td>#</td>
<td>Indicates the network stream currently used by the specified output. Select a Video button to specify a video-only breakaway.</td>
</tr>
<tr>
<td>Audio (read-only)</td>
<td>#</td>
<td>Indicates the network stream currently used by the specified output. Select an Audio button to specify an audio-only receiver for a breakaway</td>
</tr>
<tr>
<td>Status (read-only)</td>
<td>OK (Green)</td>
<td>No errors are detected on this output</td>
</tr>
<tr>
<td></td>
<td>Alarm Suppressed (Yellow/Red)</td>
<td>An alarm condition is present, but the alarm is disabled on the Alarm Enable tab</td>
</tr>
</tbody>
</table>
Stream Sources Area

The Stream Sources area is located on the bottom half of the Connections tab. From this area you can route any source signal to an output, monitor its status, and filter the stream available based on type.

Each button displayed here represents a configured network stream. You can filter what network streams are displayed using the Filter field (filtering according to the text entered in the field), by selecting one of the Stream Sources buttons (displays only the network streams assigned to that Category), and/or using the Show options (All Streams, Network Streams, or Advertised Streams).

<table>
<thead>
<tr>
<th>Item</th>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Status (read-only)</td>
<td>Network Delay Too Big (Yellow)</td>
<td>The link offset selected by the user is smaller than the propagation delay of the network</td>
</tr>
<tr>
<td>No Packets Received (Yellow)</td>
<td></td>
<td>The configured destination IP stream(s) is not receiving any packets; stream might not be on the network or experiencing other issues</td>
</tr>
<tr>
<td>System Clock Is In Failure (Red)</td>
<td></td>
<td>The NEWT-IPX is unable to re-obtain a stable clock source. Sessions cannot be created until this condition is fixed.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>It is recommended to navigate to the Advanced &gt; Timing &gt; PTP tab to check the status of the PTP and update the Configuration settings.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Once PTP is locked again, the Network Groups will need to be disconnected and then re-connected to clear the alarm.</td>
</tr>
<tr>
<td>Param Out Of Range (Red)</td>
<td></td>
<td>One of the following is occurring:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• A Destination was configured with an invalid setting</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Two receivers with the same network stream were created. The NEWT-IPX can only subscribe to a stream once.</td>
</tr>
<tr>
<td>RTP Alignment Failure (Red)</td>
<td></td>
<td>There is a discrepancy between the programmed video alignment, the RTP timestamps in the network stream and when the stream is actually played out</td>
</tr>
<tr>
<td>Disconnected (Gray)</td>
<td></td>
<td>This SDI output is disabled</td>
</tr>
<tr>
<td>Connection (read-only)</td>
<td></td>
<td>Indicates the connection status between the selected input and output</td>
</tr>
<tr>
<td>Disconnected</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Details</td>
<td></td>
<td>Opens the Details dialog that provides more information about the state of the connection</td>
</tr>
</tbody>
</table>
Once a **Destination** is selected, clicking a **Stream Source** button performs an immediate switch (a hot-punch).

**Network Streams Tab**

The options in the Network Streams tab enable you to create and manage the IP streams in your system. Advertised streams are those that the NEWT-IPX automatically detects as defined by the RAVENNA protocol. You can also define a stream by manually populating the Transport IP, Port, and DSCP fields for the video and audio signals.

Once a Network Stream is defined, it is made available for use in the **Connections** tab.

If the **ST 2022-7/Seamless Protection Switching** box is selected in the Setup tab, an extra Video row and an extra Audio row displays for Protection Switching setup for a stream.

**Table 6** outlines the options displayed in the Network Streams tab starting from the left-most area of the tab.

<table>
<thead>
<tr>
<th>Item</th>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Configure Receiver Network Stream Groups</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>List</td>
<td>&lt;name&gt;</td>
<td>Lists the configured groups for the NEWT-IPX</td>
</tr>
</tbody>
</table>
### Add Group
Enables you to configure a new stream group.

### Remove Group
Deletes the selected group.

### Group Name
Specifies a unique identifier for the group.

### Group Category
Assigns the stream to a type of essence. This is useful when filtering the streams on the Connections tab.

### # Audio Streams
Specifies the number of audio streams available in the stream group. The default value is 2.

### Assign Manually
- **Selected** Enables you to manually enter the Transport IP, Port, and DSCP fields for a specific session. This is useful when accessing non-RAVENNA streams.
- **Cleared** The Transport IP, Port, and DSCP fields are determined by the assigned Advertised Stream.

### Advertised Network Streams
- **Video**
  - *None*
  - *
- **Audio**
  - *None*
  - *
- **Format**
  - *

### Manually Specified Streams
- **Stream Name**
  - `<name>` Assigns a unique identifier for the stream.
- **Transport IP**
  - `#.#.#.#` Specifies the network socket for the video/audio data for the session. This value is auto-populated when you select an Advertised Stream.
- **UDP Port**
  - *
- **# Ch**
  - *

### Protection Switching
- **Stream Name**
  - `<name>` Assigns a unique identifier for the stream.
- **Transport IP**
  - `#.#.#.#` Specifies the network socket for the video/audio data for the session. This value is auto-populated when you select an Advertised Stream.

---

**Table 6 Network Streams Tab**

<table>
<thead>
<tr>
<th>Item</th>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add Group</td>
<td></td>
<td>Enables you to configure a new stream group</td>
</tr>
<tr>
<td>Remove Group</td>
<td></td>
<td>Deletes the selected group</td>
</tr>
<tr>
<td>Group Name &lt;text&gt;</td>
<td></td>
<td>Specifies a unique identifier for the group</td>
</tr>
<tr>
<td>Group Category</td>
<td></td>
<td>Assigns the stream to a type of essence. This is useful when filtering the streams on the Connections tab.</td>
</tr>
<tr>
<td># Audio Streams #</td>
<td></td>
<td>Specifies the number of audio streams available in the stream group. The default value is 2.</td>
</tr>
<tr>
<td>Assign Manually</td>
<td>Selected</td>
<td>Enables you to manually enter the Transport IP, Port, and DSCP fields for a specific session. This is useful when accessing non-RAVENNA streams.</td>
</tr>
<tr>
<td></td>
<td>Cleared</td>
<td>The Transport IP, Port, and DSCP fields are determined by the assigned Advertised Stream.</td>
</tr>
<tr>
<td>Video</td>
<td>None</td>
<td>Lists the discovered RAVENNA sessions. Select a session to auto-fill the Video and/or Audio fields.</td>
</tr>
<tr>
<td>Audio #</td>
<td>None</td>
<td></td>
</tr>
<tr>
<td>Format</td>
<td>#</td>
<td>Specifies the video format of the signal available for the stream</td>
</tr>
<tr>
<td>Stream Name &lt;name&gt;</td>
<td></td>
<td>Assigns a unique identifier for the stream</td>
</tr>
<tr>
<td>Transport IP #.#.#.#</td>
<td></td>
<td>Specifies the network socket for the video/audio data for the session. This value is auto-populated when you select an Advertised Stream.</td>
</tr>
<tr>
<td>UDP Port</td>
<td>#</td>
<td>Specifies the source port to connect to the advertised stream. This must match the source you are attempting to connect to.</td>
</tr>
<tr>
<td># Ch</td>
<td>#</td>
<td>Specifies the maximum number of audio channels in the specified stream</td>
</tr>
<tr>
<td>Stream Name &lt;name&gt;</td>
<td></td>
<td>Assigns a unique identifier for the stream</td>
</tr>
<tr>
<td>Transport IP #.#.#.#</td>
<td></td>
<td>Specifies the network socket for the video/audio data for the session. This value is auto-populated when you select an Advertised Stream.</td>
</tr>
</tbody>
</table>
Advanced Tabs
The Advanced sub-tabs expand the controls available in the Initial Setup tab.

Status Tab
The Status tab provides read-only hardware information, signal status, and general product information for your NEWT-IPX. The tab is organized into three distinct areas in the DashBoard window: Signal, Product, and Hardware.

Table 6 Network Streams Tab

<table>
<thead>
<tr>
<th>Item</th>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>UDP Port</td>
<td>#</td>
<td>Specifies the source port to connect to the advertised stream. This must match the source you are attempting to connect to.</td>
</tr>
<tr>
<td># Ch</td>
<td>#</td>
<td>Specifies the maximum number of audio channels in the specified stream</td>
</tr>
</tbody>
</table>

Audio Map

<table>
<thead>
<tr>
<th>Target</th>
<th>Use the audio map to assign audio channels, and determine their hierarchy, to an audio stream</th>
</tr>
</thead>
</table>
| Default Mapping | Selected | Applies a default audio mapping of 1:1 where:  
|       | • Target 1-8 is mapped to A1-A8  
|       | • Target 9-16 is mapped to B1-B8 etc.        |
| Cleared | The default audio map is not applied; user can assign audio channels as required |
| Edit   | Click to display the audio map editing options  |

Advanced Tabs
The Advanced sub-tabs expand the controls available in the Initial Setup tab.

Status Tab
The Status tab provides read-only hardware information, signal status, and general product information for your NEWT-IPX. The tab is organized into three distinct areas in the DashBoard window: Signal, Product, and Hardware.

* If the Operational Mode is set to 2-in/2-out SDI/IP Converter, the SDI Inputs sub-tab also displays.
Alarm Status Area

*Table 7* summarizes the read-only information displayed in the Device > Alarm Status area.

**Table 7 Status Tab — Alarm Status**

<table>
<thead>
<tr>
<th>Item</th>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Device Setup Tab Changes</td>
<td>Reports if there are unsaved changes made to the Advanced &gt; Device Setup tab</td>
<td></td>
</tr>
<tr>
<td>Discovery Tab Changes</td>
<td>Reports if there are unsaved changes made to the Advanced &gt; Discovery tab</td>
<td></td>
</tr>
<tr>
<td>Timing PTP Tab Changes</td>
<td>Reports if there are unsaved changes made to the Advanced &gt; Timing &gt; PTP tab</td>
<td></td>
</tr>
<tr>
<td>Timing Output Tab Changes</td>
<td>Reports if there are unsaved changes made to the Advanced &gt; Timing &gt; Outputs tab</td>
<td></td>
</tr>
<tr>
<td>PattGen Tab Changes</td>
<td>Reports there are unsaved changes made to the Advanced &gt; PattGen tab</td>
<td></td>
</tr>
<tr>
<td>System Clock Status</td>
<td>Reports the status of the PTP Clock connection</td>
<td></td>
</tr>
<tr>
<td>Control RJ-45 Status</td>
<td>Reports the same information as the Advanced &gt; Ethernet I/O &gt; Control RJ-45 &gt; Link Status field. Refer to <em>Table 13</em> for more information.</td>
<td></td>
</tr>
<tr>
<td>NET Status</td>
<td>Reports the same information as the Advanced &gt; Ethernet I/O &gt; NET # &gt; Link Status fields. Refer to <em>Table 13</em> for more information.</td>
<td></td>
</tr>
<tr>
<td>Receivers Status</td>
<td>Reports the same information as the individual alarms in the Receivers tab. Refer to “Receivers Tabs”.</td>
<td></td>
</tr>
<tr>
<td>Senders Status and Changes</td>
<td>Reports if there are unsaved changes made to the Advanced &gt; Senders tab</td>
<td></td>
</tr>
<tr>
<td>SDI Inputs Status</td>
<td>Reports the same information as the Advanced &gt; Status &gt; SDI Inputs status fields. Refer to <em>Table 10</em> for more information</td>
<td></td>
</tr>
</tbody>
</table>

Product Area

*Table 8* summarizes the read-only information displayed in the Device > Product area.

**Table 8 Status Tab — Product**

<table>
<thead>
<tr>
<th>Item</th>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Product</td>
<td></td>
<td>Indicates the product name of the module</td>
</tr>
<tr>
<td>Variant</td>
<td></td>
<td>Indicates the option(s) enabled on the module</td>
</tr>
<tr>
<td>Supplier</td>
<td></td>
<td>Indicates the supplier/manufacturer of the device</td>
</tr>
<tr>
<td>Firmware Version</td>
<td>#</td>
<td>Indicates the firmware version running on the module</td>
</tr>
<tr>
<td>Firmware Date</td>
<td>#</td>
<td>Indicates the date the current firmware was loaded on to the module</td>
</tr>
<tr>
<td>FPGA Name</td>
<td>#</td>
<td>Indicates the FPGA load running on the module</td>
</tr>
</tbody>
</table>
Hardware Area

Table 9 summarizes the read-only information displayed in the Device > Hardware area.

<table>
<thead>
<tr>
<th>Item</th>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>FPGA Temperature</td>
<td>#</td>
<td>Indicates the FPGA Core temperature.</td>
</tr>
<tr>
<td>Serial Number</td>
<td>#</td>
<td>Indicates the factory installed serial number of the module.</td>
</tr>
</tbody>
</table>

SDI Inputs Tab

The SDI Inputs tab only displays when the Operational Mode is set to 2-in/2-out SDI/IP Converter.

Table 10 summarizes the read-only information displayed in the SDI Inputs tab.

<table>
<thead>
<tr>
<th>Item</th>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SDI #</td>
<td>Status</td>
<td>OK (Green)</td>
</tr>
<tr>
<td></td>
<td>Status</td>
<td>Indicates the SDI input signal is detected and valid</td>
</tr>
</tbody>
</table>
Table 10 Status Tab — SDI Inputs Tab

<table>
<thead>
<tr>
<th>Item</th>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Status</td>
<td>No Input (Red)</td>
<td>Indicates one of the following is occurring:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• the SDI input signal is not detected</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• the system frame rate does not match the input frame rate</td>
</tr>
<tr>
<td>Video</td>
<td>#</td>
<td>Indicates the video input signal format</td>
</tr>
<tr>
<td>Audio</td>
<td># channels, Sample rate: #</td>
<td>Indicates the number of audio groups that are present in the specified input signal, and the sample rate of the AES signal</td>
</tr>
<tr>
<td>...</td>
<td></td>
<td>Displays additional audio status information for the specified SDI input signal</td>
</tr>
</tbody>
</table>

Table 11 summarizes the read-only information displayed when the ... button is selected for an SDI row.

Table 11 SDI Inputs Tab — SDI Inputs, Additional Information

<table>
<thead>
<tr>
<th>Item</th>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Audio CH #</td>
<td>Present</td>
<td>Indicates the specified audio channel is detected</td>
</tr>
<tr>
<td></td>
<td>No Signal</td>
<td>Indicates the specified audio channel is not available</td>
</tr>
</tbody>
</table>

Device Setup Tab

The Device Setup tab provides settings such as Device Name, DashBoard settings, and operational modes.
Table 12 summarizes the options displayed in the Device Setup tab.

<table>
<thead>
<tr>
<th>Item</th>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Device Settings</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Device Name</td>
<td>&lt;text&gt;</td>
<td>Specifies a unique identifier for this NEWT-IPX. This name is used to identify the streams the NEWT-IPX is managing.</td>
</tr>
<tr>
<td>System Frame Rate</td>
<td>Integer Rates (50, 60, 25)</td>
<td>Inputs, senders, and receivers must use a video format that matches this rate. This setting is updated and applied once PTP is locked.</td>
</tr>
<tr>
<td></td>
<td>Non-Integer Rates (59.94, 29.97)</td>
<td></td>
</tr>
<tr>
<td>Audio Packet Time</td>
<td>1ms</td>
<td>Adds an offset to the audio streams if you suspect the audio packets may be received out of order or delayed. This impacts all connected audio streams. Applying a new Audio Packet Time automatically disconnects all audio streams. It is recommended to set the Audio Packet Time before configuring your audio streams.</td>
</tr>
<tr>
<td></td>
<td>125us</td>
<td></td>
</tr>
<tr>
<td>Audio Channel Count Mode</td>
<td>#</td>
<td>Specifies the default number of audio channel available for configuration. The default is 8.</td>
</tr>
<tr>
<td>SMPTE ST 2110-20 Sender Payload Type</td>
<td>#</td>
<td>Specifies the 7-bit numeric value that identifies the SMPTE 2110-20 RTP payload format the NEWT-IPX supports. The default is 98.</td>
</tr>
<tr>
<td>SMPTE ST 2110-30 Sender Payload Type</td>
<td>#</td>
<td>Specifies the 7-bit numeric value that identifies the SMPTE 2110-30 RTP payload format the NEWT-IPX supports. The default is 97.</td>
</tr>
<tr>
<td>Auto Generate Sender Multicast</td>
<td>Selected</td>
<td>Enables the NEWT-IPX to choose a random IP Address for any stream when its IP Address field is set to 0.0.0.0.</td>
</tr>
<tr>
<td></td>
<td>Cleared</td>
<td>Disables this feature. An IP Address must be specified for all streams.</td>
</tr>
<tr>
<td>Enable Source Specific Multicast</td>
<td>Selected</td>
<td>The NEWT-IPX receiver monitors traffic for a specific destination multicast address and also the receiving traffic from only one specific source sending to that multicast address (via SSM).</td>
</tr>
<tr>
<td></td>
<td>Cleared</td>
<td>NEWT-IPX will use Any-Source Multicast (ASM) where the receivers will monitor traffic for a specific destination multicast address. This is the default.</td>
</tr>
<tr>
<td>Reset All</td>
<td>Load Factory Defaults</td>
<td>Sets certain editable settings to the default values</td>
</tr>
</tbody>
</table>
Licensing Tab

Ross Video uses license keys to control user access to specific NEWT-IPX features. You manage your license keys via the options in the Advanced > Licensing tab. Refer to “Licensed Features” for details.

<table>
<thead>
<tr>
<th>Item</th>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>HDMI Quad-Split Mode</td>
<td>Selected</td>
<td>Enables you to configure four independent network streams and assign them to a quadrant in a single HDMI output stream. The Connections, Network Streams, and Alarms tabs now displays options for assigning/monitoring the four QUAD outputs.</td>
</tr>
<tr>
<td></td>
<td>Cleared</td>
<td>Disables this feature</td>
</tr>
<tr>
<td>DashBoard Settings</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Hide Welcome Tab</td>
<td>Selected</td>
<td>The Welcome tab does not display in the DashBoard window</td>
</tr>
<tr>
<td></td>
<td>Cleared</td>
<td>The Welcome tab displays in the DashBoard window</td>
</tr>
<tr>
<td>Hide Initial Setup Wizard Tab</td>
<td>Selected</td>
<td>The Initial Setup tab does not display in the DashBoard window</td>
</tr>
<tr>
<td></td>
<td>Cleared</td>
<td>The Initial Setup tab displays in the DashBoard window</td>
</tr>
<tr>
<td>Transport Options</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SMPTE ST 2022-7/Seamless Protection Switching</td>
<td>Selected</td>
<td>Enables you to protect your streams by allowing the NET ports to carry a protection stream when operating in a redundant network</td>
</tr>
<tr>
<td></td>
<td>Cleared</td>
<td>Disables this feature</td>
</tr>
<tr>
<td>Current Operational Mode (read-only)</td>
<td>IP to 4x3G-SDI Gateway</td>
<td>Reports what Operational Mode the NEWT-IPX is set to. Use this field to identify the number and type of outputs that are enabled on the module.</td>
</tr>
<tr>
<td></td>
<td>UHD-over-IP to HDMI 2.0 Gateway</td>
<td></td>
</tr>
<tr>
<td></td>
<td>2-in/2-out SDI/IP Converter</td>
<td></td>
</tr>
<tr>
<td>Operational Mode on Reboot</td>
<td>IP to 4x3G-SDI Gateway</td>
<td>The NEWT-IPX is configured to operate with: • Two NET inputs • Four SDI outputs</td>
</tr>
<tr>
<td></td>
<td>UHD-over-IP to HDMI 2.0 Gateway</td>
<td>The NEWT-IPX is configured to operate with: • Two NET inputs • One HDMI 2.0 output</td>
</tr>
<tr>
<td></td>
<td>2-in/2-out SDI/IP Converter</td>
<td>The NEWT-IPX is configured to operate with: • Two bi-directional NET ports • Two SDI inputs • Two SDI outputs</td>
</tr>
</tbody>
</table>
Ethernet I/O Tab

Use the Ethernet I/O tab to configure the network settings for the CONTROL, NET 1, and NET 2 ports on the NEWT-IPX.

Network Setup Area

Table 13 summarizes the fields and menus displayed for configuring the network settings of the CONTROL and NET ports. Note that each port is configured independently.
The Special Multicast Addresses options should only be configured under the guidance of Ross Technical Support.

Table 13 Ethernet I/O — Network Setup

<table>
<thead>
<tr>
<th>Item</th>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Link Status</td>
<td>OK (Green)</td>
<td>The link for the specified port is valid</td>
</tr>
<tr>
<td>Alarm suppressed</td>
<td></td>
<td>The Link Down or Not Present boxes in the Alarm Enable tab is cleared (not selected) for this port</td>
</tr>
<tr>
<td>Not Present (Yellow)</td>
<td></td>
<td>No SFP Module is detected in the NET port</td>
</tr>
<tr>
<td>Link Down (Red)</td>
<td></td>
<td>The link for the specified port is invalid (fails)</td>
</tr>
<tr>
<td>Current IP</td>
<td>#</td>
<td>Indicates the IP Address currently assigned to the NEWT-IPX for the specified port</td>
</tr>
<tr>
<td>MAC Address</td>
<td>#</td>
<td>Indicates the MAC Address currently assigned to the NEWT-IPX for the specified port</td>
</tr>
<tr>
<td>Mode</td>
<td>Static</td>
<td>The user manually supplies the network settings for the specified port</td>
</tr>
<tr>
<td></td>
<td>DHCP</td>
<td>Automates the assignment of the network settings for the specified port</td>
</tr>
<tr>
<td>Static IP Address</td>
<td>#</td>
<td>Specifies the static IP Address for the NEWT-IPX the user wants to manually assign to the specified port</td>
</tr>
<tr>
<td>Subnet Mask</td>
<td>#</td>
<td>The subnet mask for the specified port</td>
</tr>
<tr>
<td>Gateway</td>
<td>#</td>
<td>The gateway for communications outside of the local area network (LAN)</td>
</tr>
</tbody>
</table>

Status Area

Table 14 summarizes the read-only fields displayed for each NET port.

Table 14 Ethernet I/O — Status

<table>
<thead>
<tr>
<th>Item</th>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Temperature (Celsius)</td>
<td>#</td>
<td>Internal temperature as reported by the specified NET port</td>
</tr>
<tr>
<td>Wavelength (nm)</td>
<td>#</td>
<td>Indicates the transmitted wavelength</td>
</tr>
<tr>
<td>Part Number</td>
<td>#</td>
<td>Indicates the part number of the module installed in the specified NET port</td>
</tr>
<tr>
<td>Rx Bandwidth Used</td>
<td>#</td>
<td>Reports the amount of data the NEWT-IPX is currently receiving on the specified NET port</td>
</tr>
<tr>
<td>Tx Bandwidth Used</td>
<td>#</td>
<td>Reports the amount of data the NEWT-IPX is currently transmitting on the specified NET port</td>
</tr>
</tbody>
</table>
Receivers Tabs

The Receivers tab is organized into two sub-tabs: Status and X-Connect.

Status Tab

The **Status** tab provides details on each of the IP receivers (NET ports) of the NEWT-IPX. The top of the Status tab displays a read-only field for each configured NET port on the NEWT-IPX. These fields report the expected bandwidth allocated by the Receiver NET port.

- The value displayed within each bar indicates the expected port utilization by the active receivers.

![Figure 35 Receivers > Status Tab — Example of the NET Bandwidth Area](image)

If the bandwidth bar is green, the expected allocated bandwidth is below 100%.

The SDI Receiver area of the tab, located at the bottom, duplicates the information reported in the Connections tab. Each SDI is represented as a row in the tab and provides the items and parameters.

![Figure 36 Receivers >Status Tab — Example of the SDI Receiver Area with Four SDI Outputs](image)

**Table 15** outlines the read-only fields and menus available to configure the receiver settings for each SDI.

<table>
<thead>
<tr>
<th>Item</th>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Status (read-only)</td>
<td>OK (Green)</td>
<td>No errors are detected on this SDI connection</td>
</tr>
<tr>
<td>Alarm Suppressed (Yellow/Red)</td>
<td></td>
<td>An alarm condition is present, but the alarm is disabled on the Alarm Enable tab</td>
</tr>
<tr>
<td>Apply Changes (Yellow)</td>
<td></td>
<td>This receiver has unsaved settings. Click <strong>Apply</strong> at the bottom of the tab to save your settings.</td>
</tr>
<tr>
<td>Network Delay Too Big (Yellow)</td>
<td></td>
<td>The link offset selected by the user is smaller than the propagation delay of the network</td>
</tr>
</tbody>
</table>
Table 16 summarizes the read-only information that displays when the button is selected at the end of a row.

If the ST 2222-7/Seamless Protection Switching box is selected in the Setup tab, an extra Video row and an extra Audio row displays for Protection Switching setup.

### Table 15  Receivers > Status Tab — SDI Receiver Configuration Area

<table>
<thead>
<tr>
<th>Item</th>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Status (read-only)</td>
<td>No packets received (Yellow)</td>
<td>The configured receiver IP stream(s) is not receiving any packets; stream might not be on the network or experiencing other issues</td>
</tr>
<tr>
<td>Param Out of Range (Red)</td>
<td>Two receivers with the same network stream were created. NEWT-IPX can only subscribe to a stream once.</td>
<td></td>
</tr>
<tr>
<td>System clock is in failure (Red)</td>
<td>The NEWT-IPX is unable to re-obtain a stable clock source. Sessions cannot be created until this condition is fixed. It is recommended to navigate to the Timing &gt; PTP tab to check the status of the PTP and update the Configuration settings. Once PTP is locked again, the Network Groups will need to be disconnected and then re-connected to clear the alarm.</td>
<td></td>
</tr>
<tr>
<td>Not In Use (Gray)</td>
<td>Indicates the SDI port is not actively in use; verify the connection on the physical port of the chassis</td>
<td></td>
</tr>
<tr>
<td>Name</td>
<td>&lt;text&gt;</td>
<td>Assigns an unique identifier to the receiver stream</td>
</tr>
<tr>
<td>Format (read-only)</td>
<td>#</td>
<td>Indicates the video format detected on the stream</td>
</tr>
<tr>
<td></td>
<td>Unknown</td>
<td>Indicates the detected format is unsupported</td>
</tr>
<tr>
<td>NET (read-only)</td>
<td>Auto</td>
<td>The NEWT-IPX automatically selects the available NET port</td>
</tr>
<tr>
<td>Disconnect</td>
<td>Stops that session and the Receiver outputs black</td>
<td></td>
</tr>
</tbody>
</table>

### Table 16  Receivers > Status Tab — Additional Status

<table>
<thead>
<tr>
<th>Item</th>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Video</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Status</td>
<td>OK (Green)</td>
<td>No errors are detected on the video signal</td>
</tr>
<tr>
<td></td>
<td>Alarm suppressed (Yellow/Red)</td>
<td>An alarm condition is present, but the alarm is disabled on the Alarm Enable tab</td>
</tr>
<tr>
<td></td>
<td>Not in Use (Gray)</td>
<td>This SDI video stream is disabled</td>
</tr>
<tr>
<td>Source Name</td>
<td>xx.yy.video</td>
<td>The source name is determined by the stream that is connected</td>
</tr>
</tbody>
</table>
### Table 16 Receivers > Status Tab — Additional Status

<table>
<thead>
<tr>
<th>Item</th>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transport IP</td>
<td>#</td>
<td>Specifies the IP Address for the video stream</td>
</tr>
<tr>
<td></td>
<td>&lt;blank&gt;</td>
<td>The NEWT-IPX firmware provides an IP when the session is created</td>
</tr>
<tr>
<td>Source IP</td>
<td>#</td>
<td>Specifies the destination multicast address that the NEWT-IPX receiver will monitor traffic when SSM is enabled. This field only displays when the Device Setup &gt; Enable Source Specific Multicast box is selected.</td>
</tr>
<tr>
<td>Port</td>
<td>#</td>
<td>Indicates the port associated with the IP address and the communication protocol for the video essence</td>
</tr>
<tr>
<td>NET</td>
<td>#</td>
<td>Indicates the NET port that the video signal is derived from</td>
</tr>
<tr>
<td>Link Offset (us)</td>
<td>#</td>
<td>Reports the Video Delay value set in the Timing &gt; Outputs tab for the SDI output</td>
</tr>
<tr>
<td><strong>Audio #</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Status</td>
<td>OK (Green)</td>
<td>No errors are detected on the audio signal</td>
</tr>
<tr>
<td></td>
<td>Alarm suppressed (Yellow/Red)</td>
<td>An alarm condition is present, but the alarm is disabled on the Alarm Enable tab</td>
</tr>
<tr>
<td></td>
<td>Not In Use (Grey)</td>
<td>The audio channels are disabled or unavailable</td>
</tr>
<tr>
<td>Source Name</td>
<td>xx.yy.audio#</td>
<td>The source name is determined by the stream that is connected</td>
</tr>
<tr>
<td>Transport IP</td>
<td>.#.#.#.#</td>
<td>Specifies the IP Address for the audio stream</td>
</tr>
<tr>
<td></td>
<td>&lt;blank&gt;</td>
<td>The NEWT-IPX firmware provides an IP when the session is created</td>
</tr>
<tr>
<td>Source IP</td>
<td>#</td>
<td>Specifies the destination multicast address that the NEWT-IPX receiver will monitor traffic when SSM is enabled. This field only displays when the Device Setup &gt; Enable Source Specific Multicast box is selected.</td>
</tr>
<tr>
<td>Port</td>
<td>#</td>
<td>Indicates the port associated with the IP address and the communication protocol for the audio essence</td>
</tr>
<tr>
<td>NET (read-only)</td>
<td>#</td>
<td>Indicates the NET port on the NEWT-IPX that the audio signal is derived from</td>
</tr>
<tr>
<td>Link Offset (us)</td>
<td>#</td>
<td>Reports the Audio Offset and/or Audio Delay values set in the Timing &gt; Outputs tab for the SDI output</td>
</tr>
</tbody>
</table>
X-Connect Tab

The **X-Connect** tab provides read-only details on the audio mapping of the current audio receiver session(s). **Table 17** outlines the Receiver Audio Mapping read-only fields on the X-Connect tab.

<table>
<thead>
<tr>
<th>Item</th>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Session</td>
<td>#</td>
<td>Indicates the specific network session</td>
</tr>
<tr>
<td>Stream</td>
<td>#</td>
<td>Indicates the specific network stream assigned to the session</td>
</tr>
<tr>
<td>Chan #</td>
<td>#</td>
<td>Indicates the input channel assigned to the specified SDI # /Destination # output channel</td>
</tr>
</tbody>
</table>

PattGen Tab

The PattGen tab provides options for configuring a pattern generator for an SDI output. The number and type of outputs depends on the Operational Mode setting. **Figure 37** is an example of the PattGen tab when the NEWT-IPX is configured as an IP to 4x3G-SDI Gateway.

**Table 18** summarizes the options displayed in the PattGen tab.

<table>
<thead>
<tr>
<th>Item</th>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable</td>
<td>Selected</td>
<td>The specified output outputs the test pattern assigned using the Pattern menu</td>
</tr>
<tr>
<td></td>
<td>Cleared</td>
<td>Disables the pattern generator for the specified output</td>
</tr>
<tr>
<td>Format</td>
<td>#</td>
<td>Specifies the video format for the pattern generator</td>
</tr>
</tbody>
</table>
Senders Tab

The **Senders** menus are organized into two sub-tabs: Setup Streams and Active Streams. The Senders tab only displays when the NEWT-IPX is configured as an 2-in/2-out SDI/IP Converter.

Setup Streams Tab

The **Setup Streams** tab allows you to configure the sender streams for the NEWT-IPX. The **Setup Streams** tab also reports the NET bandwidth allocation. If a bandwidth bar is green, the allocated bandwidth is below 75%.

![Figure 38 Senders — Active Streams Tab](image)

If Protection Switching is enabled, a row is displayed for the redundant streams.

Active Streams Tab

**Table 19** lists the fields that display on the Active Streams tab.

<table>
<thead>
<tr>
<th>Item</th>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pattern</td>
<td>Colorbar 100% Pattern</td>
<td>Specifies the type of test pattern to output.</td>
</tr>
<tr>
<td></td>
<td>Colorbar 75% Pattern</td>
<td>Note that the test pattern replaces all of the output picture but not the HANC, while the VANC is blanked.</td>
</tr>
<tr>
<td></td>
<td>Pathological Pattern</td>
<td></td>
</tr>
</tbody>
</table>

Table 18 PattGen Tab
### Table 19  Senders — Active Streams Tab

<table>
<thead>
<tr>
<th>Item</th>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Video Streams</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Name&lt;sup&gt;a&lt;/sup&gt;</td>
<td>xx.yy</td>
<td>Provides a unique identifier for the video data available on the specified SDI input where:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• xx represents the name of the send as defined in the Advanced &gt; Senders &gt; Setup Streams tab.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• yy represents the name of the SDI input signal as defined in the Name field.</td>
</tr>
<tr>
<td>Status (read-only)</td>
<td>OK (Green)</td>
<td>The sender streams are operating correctly without errors.</td>
</tr>
<tr>
<td></td>
<td>Alarm Suppressed (Yellow/Red)</td>
<td>An alarm condition is present, but the alarm is disabled on the Alarm Enable tab</td>
</tr>
<tr>
<td></td>
<td>Apply Changes (Yellow)</td>
<td>One or more settings were changed on the Setup Streams tab. You must click Apply to update the settings on the NEWT-IPX.</td>
</tr>
<tr>
<td></td>
<td>PTP Unstable, try again (Red)</td>
<td>The NEWT-IPX is unable to obtain a stable clock source. Sessions cannot be created until this condition is fixed. It is recommended to navigate to the Advanced &gt; Timing &gt; PTP tab to check the status of the PTP and update the Configuration settings.</td>
</tr>
<tr>
<td></td>
<td>Param Out of Range (Red)</td>
<td>One of the following is occurring:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• a sender was configured with an invalid setting.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• two senders with the same network source were created. The NEWT-IPX can only subscribe to a stream once.</td>
</tr>
<tr>
<td></td>
<td>SDI Not Present (Red)</td>
<td>A valid SDI signal is not detected on the specified SDI BNC of the NEWT-IPX</td>
</tr>
<tr>
<td></td>
<td>Marked for Removal (Red)</td>
<td>The user has disabled the sender but has not clicked the Apply button yet</td>
</tr>
<tr>
<td>Transport IP</td>
<td>#.#.#.#</td>
<td>Specifies the IP Address for the video session</td>
</tr>
<tr>
<td>UDP Port</td>
<td>#</td>
<td>Indicates the port associated with the IP address and the communication protocol for the video essence</td>
</tr>
<tr>
<td>Pause</td>
<td></td>
<td>The session is paused (not active)</td>
</tr>
<tr>
<td>Remove</td>
<td></td>
<td>The sessions is stopped</td>
</tr>
<tr>
<td><strong>Audio Streams</strong></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Table 20  Senders — Setup Streams Tab

<table>
<thead>
<tr>
<th>Item</th>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
</table>
| Name                  | xx.yy      | Provides a unique identifier for the audio channels available on the specified SDI input where:  
• xx represents the name of the card as defined in the Advanced > Senders > Setup Streams tab.  
• yy represents the name of the SDI input signal as defined in the Name field |
| Status (read-only)    |            | Reports the audio activity of the session                                   |
| Transport IP          | #.#.#.#     | Specifies the IP Address for the session                                    |
| UDP Port              | #          | Indicates the port associated with the IP address and the communication protocol for the audio essence |
| Pause                 |            | The session is paused (not active)                                          |
| Remove                |            | The sessions is stopped                                                     |

When the sender is first enabled, the streams are named using the nomenclature:  
systemdevicename.sendername.video.

Setup Streams Tab

Table 20 summarizes the menus and fields available in the Setup Streams tab.

Table 20  Senders — Setup Streams Tab

<table>
<thead>
<tr>
<th>Item</th>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Source Type</td>
<td>Video</td>
<td>Specifies the type of data that the new stream will transport</td>
</tr>
<tr>
<td></td>
<td>Audio</td>
<td></td>
</tr>
<tr>
<td>Source Name</td>
<td>&lt;text&gt;</td>
<td>Provides a unique identifier for the SDI input signal. This name is used to identify the data within your network.</td>
</tr>
</tbody>
</table>

Primary Stream

Transport IP          | #          | Specifies the IP Address for the primary stream of this session          |
|                      | <blank>    | If the Device Setup > Allow Random IP box is selected, the NEWT-IPX firmware provides an IP when the session is created. |
| UDP Port              | #          | Indicates the port associated with the IP address and the communication protocol for the primary stream |

Protection Switching

Transport IP          | #          | Specifies the IP Address for the protection switch stream               |
| UDP Port              | #          | Indicates the port associated with the IP address and the communication protocol for the protection switch stream |
Discovery Tab

The Discovery tab provides options for configuring communications via third-party protocols.

![Discovery Tab](image)

Table 21 summarizes the options displayed in the Discovery tab.

<table>
<thead>
<tr>
<th>Item</th>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select Video Source</td>
<td>SDI #</td>
<td>Specifies the SDI IN port on the NEWT-IPX chassis that will supply the stream. This is disabled when the Source Type is set to Audio.</td>
</tr>
<tr>
<td>Auto Create Audio Source</td>
<td>Set Default Audio</td>
<td>Automatically maps the audio channels to the output channels in a 1:1 ratio. This button is disabled when the Source Type is set to Video.</td>
</tr>
</tbody>
</table>

Table 21 Discovery Tab

<table>
<thead>
<tr>
<th>Item</th>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>NMOS</td>
<td>&lt;text&gt;</td>
<td>Name of the NMOS node being advertised. The default name is Ross NEWT</td>
</tr>
<tr>
<td></td>
<td>Use System Device Name</td>
<td>Applies the identifier to the NMOS mode as provided by the master NMOS device</td>
</tr>
<tr>
<td>Interface</td>
<td>Control RJ-45</td>
<td>The NEWT-IPX uses its CONTROL port for NMOS communications</td>
</tr>
<tr>
<td></td>
<td>NET #</td>
<td>The NEWT-IPX uses the specified NET port for NMOS communications</td>
</tr>
<tr>
<td></td>
<td>All</td>
<td>The NEWT-IPX accepts NMOS requests via the CONTROL and all NET ports</td>
</tr>
<tr>
<td>SDP Port</td>
<td>#</td>
<td>Specifies the SDP HTTP port used to GET SDPS. The default is 0.</td>
</tr>
</tbody>
</table>
Table 21 Discovery Tab

<table>
<thead>
<tr>
<th>Item</th>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Node Port</td>
<td>#</td>
<td>Specifies the port the NMOS IS-04 Node service is listening on</td>
</tr>
<tr>
<td>Query Port</td>
<td>#</td>
<td>Specified the port the NMOS IS-04 Query service is listening on</td>
</tr>
<tr>
<td><strong>RAVENNA</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Board Name</td>
<td>&lt;text&gt;</td>
<td>Assigns a unique identifier for the NEWT-IPX when communicating with RAVENNA-based devices. The default name is <strong>Ross-Newt</strong>.</td>
</tr>
<tr>
<td>Use System Device Name</td>
<td></td>
<td>Applies the identifier to the NEWT-IPX as provided by the master RAVENNA device</td>
</tr>
<tr>
<td>Interface</td>
<td>Control Rj-45</td>
<td>The NEWT-IPX uses its CONTROL port for RAVENNA communications</td>
</tr>
<tr>
<td></td>
<td>NET #</td>
<td>The NEWT-IPX uses the specified NET port on the NEWT-IPX for RAVENNA communications</td>
</tr>
<tr>
<td></td>
<td>All</td>
<td>The NEWT-IPX accepts RAVENNA requests via the CONTROL and all NET ports</td>
</tr>
<tr>
<td>Port</td>
<td>#</td>
<td>Specifies the communications port on the network that the NEWT-IPX uses for RAVENNA communications. The default is 80.</td>
</tr>
<tr>
<td><strong>RTSP</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Interface</td>
<td>Control Rj-45</td>
<td>The NEWT-IPX uses its CONTROL port for RTSP communications</td>
</tr>
<tr>
<td></td>
<td>NET #</td>
<td>The NEWT-IPX uses the specified physical NET port for RTSP communications</td>
</tr>
<tr>
<td></td>
<td>All</td>
<td>The NEWT-IPX accepts RTSP requests via the CONTROL and all NET ports</td>
</tr>
<tr>
<td>Port</td>
<td>#</td>
<td>Specifies the TCP port the protocol uses to send and receive messages. The default is 8554.</td>
</tr>
<tr>
<td>** Ember+</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Port</td>
<td>#</td>
<td>Specifies the communications port on the network that the NEWT-IPX uses for Ember+ communications. The default is 9095.</td>
</tr>
<tr>
<td><strong>SAP</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Enable</td>
<td>Selected</td>
<td>The NEWT-IPX will use the Session Announcement Protocol (SAP) to broadcast multicast session information</td>
</tr>
<tr>
<td></td>
<td>Cleared</td>
<td>Disables this feature</td>
</tr>
<tr>
<td><strong>SLP</strong></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Timing Tab

The system timing options for the NEWT-IPX are organized into the following sub-tabs displayed on the left pane of the Timing tab: PTP and Outputs.

### Table 21 Discovery Tab

<table>
<thead>
<tr>
<th>Item</th>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable</td>
<td>Selected</td>
<td>Enables the NEWT-IPX to use the Service Location Protocol (SLP) to be automatically recognized on the local area network (LAN)</td>
</tr>
<tr>
<td></td>
<td>Cleared</td>
<td>Disables this feature</td>
</tr>
<tr>
<td>Walkabout</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Enable</td>
<td>Selected</td>
<td>Enables the Walkabout feature of DashBoard to detect the NEWT-IPX on the network</td>
</tr>
<tr>
<td></td>
<td>Cleared</td>
<td>Disables this feature</td>
</tr>
</tbody>
</table>

PTP Tab

Use the PTP tab to configure the PTP client settings for the NEWT-IPX. This is also where the NEWT-IPX is displays an active Grandmaster.

**Table 22** summarizes the options displayed in the PTP tab.

### Table 22 Timing Tab — PTP

<table>
<thead>
<tr>
<th>Item</th>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configuration</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Slave Only</td>
<td>Selected</td>
<td>Defines the NEWT-IPX as a slave only device in the system; the module cannot be used as a Grandmaster or Master device</td>
</tr>
<tr>
<td></td>
<td>Cleared</td>
<td>Enables the NEWT-IPX to be used as a Grandmaster or Master device</td>
</tr>
<tr>
<td>Item</td>
<td>Parameters</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------</td>
<td>-----------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Profile</td>
<td>IEEE 1588 Default</td>
<td>Specifies the NEWT-IPX timing uses IEEE1588 standard</td>
</tr>
<tr>
<td></td>
<td>AES67 Media</td>
<td>Specifies the NEWT-IPX timing uses AES67 Media standard</td>
</tr>
<tr>
<td></td>
<td>SMPTE ST 2059-2</td>
<td>Specifies the NEWT-IPX timing uses SMPTE ST 2059-2 standards. This is the recommended setting.</td>
</tr>
<tr>
<td>Custom PTP Profile</td>
<td>Selected</td>
<td>The Domain, Priority1, Priority2, Role status, Sync Interval, Announce Interval and Announce Receipt Timeout fields can be edited to create a custom PTP profile</td>
</tr>
<tr>
<td></td>
<td>Cleared</td>
<td>The Domain, Priority1, Priority2, Role status, Sync Interval, Announce Interval and Announce Receipt Timeout fields are set to the default values of the selected PTP Profile.</td>
</tr>
<tr>
<td>Domain</td>
<td>#</td>
<td>Specifies that the NEWT-IPX is within the specified group of clocks in your network</td>
</tr>
</tbody>
</table>
| Priority1            | #               | Assigns the first priority level to the NEWT-IPX during a Grandmaster election where a value of:  
|                      |                 | • 1 is the highest priority  
|                      |                 | • 255 is the lowest priority  
|                      |                 | This menu is applicable when the Slave Only box is not selected         |
| Priority2            | #               | Assigns the secondary priority level to the NEWT-IPX during a Grandmaster election where a value of:  
|                      |                 | • 1 is the highest priority  
|                      |                 | • 255 is the lowest priority  
|                      |                 | This menu is applicable when the Slave Only box is not selected         |
| NET #                |                 |                                                                             |
| Role Status          | #               | Indicates the role that the specified port is assigned to in the network system |
| Sync Interval        | #               | Specifies how often the NET port on the NEWT-IPX sends Sync messages        |
| Announce Interval    | #               | Specifies how often the NET port on the NEWT-IPX sends Announce messages    |
| Announce Receipt     | #               | Controls how long the NET port on the NEWT-IPX will wait before declaring the Grandmaster absent and initiating a new election |
| Timeout              |                 |                                                                             |
| Status (read-only)   |                 |                                                                             |
Table 22: Timing Tab — PTP

<table>
<thead>
<tr>
<th>Item</th>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Current Reference</td>
<td>PTP SLAVE</td>
<td>Specifies that the NEWT-IPX is a Slave; using that system clock as the reference</td>
</tr>
<tr>
<td></td>
<td>INTERNAL</td>
<td>Specifies that the NEWT-IPX is a Master; using that system clock as the reference</td>
</tr>
<tr>
<td>System Status</td>
<td>Locked</td>
<td>Status of PTP on the system</td>
</tr>
<tr>
<td></td>
<td>Free run</td>
<td></td>
</tr>
<tr>
<td>Interface Status</td>
<td>Locked</td>
<td>Status of PTP on the interface</td>
</tr>
<tr>
<td></td>
<td>Acquiring</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Fail</td>
<td></td>
</tr>
<tr>
<td>Status</td>
<td>Details</td>
<td>Reports details on detected Start of Frame (SOF) errors</td>
</tr>
<tr>
<td>Local (read-only)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Local ID</td>
<td>#</td>
<td>Reports the ID number assigned to the NEWT-IPX within the system</td>
</tr>
<tr>
<td>Mean Path Delay</td>
<td>#</td>
<td>Average time in nanoseconds it takes a packet to traverse end to end from the PTP master</td>
</tr>
<tr>
<td>Offset From Master</td>
<td>#</td>
<td>Correction time offset from the master in nanoseconds</td>
</tr>
<tr>
<td>Min Delay Request</td>
<td>#</td>
<td>Specifies how long the NEWT-IPX will wait for a delay request</td>
</tr>
<tr>
<td>Interval</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Grandmaster</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Grandmaster ID</td>
<td>#</td>
<td>Reports the ID number assigned to the Grandmaster within the system</td>
</tr>
<tr>
<td>Priority1</td>
<td>#</td>
<td>Standard PTP fields used to determine who wins a PTP election</td>
</tr>
<tr>
<td>Priority2</td>
<td>#</td>
<td></td>
</tr>
<tr>
<td>Clock Accuracy</td>
<td>#</td>
<td>Standard PTP field that states the accuracy of the system clock on the system</td>
</tr>
<tr>
<td>Clock Class</td>
<td>#</td>
<td>Standard PTP field that states the class of the clock used on the system</td>
</tr>
</tbody>
</table>

Outputs Tab

The Outputs tab automatically displays in the DashBoard window. The Outputs tab enables you to adjust the timing of each SDI output.

Table 23 summarizes the options displayed in the Outputs tab for each SDI output.
Alarms Tab

The **Alarms** tab enables you to manage the type of alarms the NEWT-IPX reports.

Table 24 summarizes the options displayed in the Alarms tab.

Table 23 **Timing Tab — Outputs**

<table>
<thead>
<tr>
<th>Item</th>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default Delay</td>
<td>Selected</td>
<td>The default for audio and video delays change based on the audio packet time set on the device. If the audio packet time is 1ms (1000us) to default video delay is 16000us and audio delay is 16000us. If the audio packet time is 125us to default video delay is 2000us and audio delay is 2000us.</td>
</tr>
<tr>
<td></td>
<td>Cleared</td>
<td>NEWT-IPX applies the delay and offset settings in the Outputs tab for the specified signal</td>
</tr>
<tr>
<td>Audio Offset (us)</td>
<td>#</td>
<td>Changes the link offset values used when a receiver is setup</td>
</tr>
<tr>
<td>Audio Delay (us)</td>
<td>#</td>
<td>Reports the audio output delay (Video Delay value + Audio Offset value) relative to the selected reference</td>
</tr>
</tbody>
</table>

![Figure 41 Alarms Tab — Operational Mode set to 2-in/2-out SDI/IP Converter](image)

* All alarms are enabled by default.
### Table 24 Alarms Tab

<table>
<thead>
<tr>
<th>Item</th>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Receiver Streams - SDI #a</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Video Stream</td>
<td>Selected</td>
<td>Enables the monitoring of the video signal of the stream. The status is reported in the Destinations area of the Connections tab.</td>
</tr>
<tr>
<td></td>
<td>Cleared</td>
<td>Disables monitoring of this stream</td>
</tr>
<tr>
<td>Audio Stream</td>
<td>Selected</td>
<td>Enables the monitoring of the audio stream. The status is reported in the Destinations area of the Connections tab.</td>
</tr>
<tr>
<td></td>
<td>Cleared</td>
<td>Disables monitoring of this stream</td>
</tr>
<tr>
<td><strong>Sender Streams - Primary, Protection Switching</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Video Stream</td>
<td>Selected</td>
<td>The Advanced &gt; Senders &gt; Active Streams tab monitors the configured video streams of the NEWT-IPX</td>
</tr>
<tr>
<td></td>
<td>Cleared</td>
<td>Disables monitoring of the sender video stream(s)</td>
</tr>
<tr>
<td>Audio Stream</td>
<td>Selected</td>
<td>The Advanced &gt; Senders &gt; Active Streams tab monitors the configured audio streams of the NEWT-IPX</td>
</tr>
<tr>
<td></td>
<td>Cleared</td>
<td>Disables monitoring of the sender audio stream(s)</td>
</tr>
<tr>
<td><strong>Sender Setup - Status</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Connection</td>
<td>Selected</td>
<td>Changes made to the Advanced &gt; Senders &gt; Setup Streams tab are reported in the Advanced &gt; Status &gt; Device tab.</td>
</tr>
<tr>
<td></td>
<td>Cleared</td>
<td>Disables monitoring of the menus on the Advanced &gt; Senders tab. The Senders Status and Changes field in the Advanced &gt; Device tab does not report any issues.</td>
</tr>
<tr>
<td><strong>SDI Inputs - SDI #</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Video Missing</td>
<td>Selected</td>
<td>The Advanced &gt; SDI Inputs status fields report when the video data on the specified SDI IN port is not detected</td>
</tr>
<tr>
<td></td>
<td>Cleared</td>
<td>Disables monitoring of the specified SDI IN port</td>
</tr>
<tr>
<td>Audio Missing</td>
<td>Selected</td>
<td>The Advanced &gt; SDI Inputs status fields report when the audio data on the specified SDI IN port is not detected</td>
</tr>
<tr>
<td></td>
<td>Cleared</td>
<td>Disables monitoring of this</td>
</tr>
<tr>
<td><strong>Ethernet - Control RJ-45</strong></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
The Logs tab is organized into two sub-tabs: System Log and Captures.

**System Log Tab**

The System Log tab provides a system log interface that reports tasks, messages, and other operating information in a table format. This is useful when troubleshooting with the help of Ross Technical Support.

**Captures Tab**

The Captures tab displays a list of log entries that were captured.

**Table 25** summarizes the options displayed in the Captures tab.

<table>
<thead>
<tr>
<th>Item</th>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>&lt;text&gt;</td>
<td>Lists the recent debug, core, and PCAP files currently available for download. Select the Refresh button in the top right corner to update the list.</td>
</tr>
<tr>
<td>Size (bytes)</td>
<td>#</td>
<td>Indicates the size of the file</td>
</tr>
<tr>
<td>Request Debug</td>
<td></td>
<td>Creates a file that captures the log entries and device status information of the NEWT-IPX</td>
</tr>
<tr>
<td>Duration [s]</td>
<td>#</td>
<td>Specifies the length of time (in seconds) to perform a packet capture (PCAP)</td>
</tr>
</tbody>
</table>
**Table 25 Logs Tab — Captures**

<table>
<thead>
<tr>
<th>Item</th>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Packet Capture</td>
<td></td>
<td>Captures a PCAP file on the port specified in the Interface menu</td>
</tr>
<tr>
<td>Interface</td>
<td>eth0</td>
<td>Captures a PCAP file for the CONTROL port of the NEWT-IPX</td>
</tr>
<tr>
<td></td>
<td>eth1</td>
<td>Captures a PCAP file for the NET 1 port of the NEWT-IPX</td>
</tr>
<tr>
<td></td>
<td>eth2</td>
<td>Captures a PCAP file for the NET 2 port of the NEWT-IPX</td>
</tr>
</tbody>
</table>

**Diagnostics Tab**

The Diagnostics tab provides additional read-only information to help troubleshoot the network communication activity, and the video output stream status.

**Network Diagnostics**

This section summarizes the Network Diagnostics fields that are displayed after the Show Network Diagnostics button is selected.

![Image of Diagnostics Tab](image)

**Table 26 Diagnostics Tab**

<table>
<thead>
<tr>
<th>Item</th>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Network Diagnostics - NET # &gt; Link Statistics</td>
<td></td>
<td>Reports the total number of error packets which are received on the specified NET port</td>
</tr>
<tr>
<td>Rx Errors</td>
<td>#</td>
<td>Reports the total number of error packets which are transmitted on the specified NET port</td>
</tr>
<tr>
<td>Tx Errors</td>
<td>#</td>
<td></td>
</tr>
</tbody>
</table>
Video Output Stream Diagnostics

The Video Output Stream Diagnostics area can display the following information for any video stream:

- A graph of the Video Frame Buffer Fill level over time (with maximum and minimum levels indicated separately)
- A graph of the Pixel FIFO Fill level over time (with maximum and minimum levels indicated separately)
- A running count of missing packets, invalid packets, frame drops, frame replays
- A current view of memory statistics such as a read/write counter, the read/write pointers, the RTP timestamp alignment errors, and a view of per-stream interrupts (such as pending missing markers, and pending frame drops)

Any connected video stream can be monitored when they are connected. If disconnected, the video stream is also removed from the monitoring list in this tab.

The Video Output Stream Diagnostics area of the tab enables you to specify the SDI output and type of stream to monitor. **Figure 43** shows an example where the user is monitoring the video stream on SDI 3.

<table>
<thead>
<tr>
<th>Item</th>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rx Bandwidth</td>
<td>#</td>
<td>Reports the amount of data the NEWT-IPX is currently receiving on the specified NET port</td>
</tr>
<tr>
<td>Tx Bandwidth</td>
<td>#</td>
<td>Reports the amount of data the NEWT-IPX is currently transmitting on the specified NET port</td>
</tr>
</tbody>
</table>

**Network Diagnostics - NET # > CPU Statistics**

<table>
<thead>
<tr>
<th>Item</th>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rx Errors</td>
<td>#</td>
<td>Reports the total number of errors packets received on the 10G link</td>
</tr>
<tr>
<td>Tx Errors</td>
<td>#</td>
<td>Reports the total number of errors packets sent on the 10G link</td>
</tr>
<tr>
<td>Rx Bandwidth</td>
<td>#</td>
<td>Reports the packets received on the 10G link and forwarded to the processor on the specified NET port</td>
</tr>
<tr>
<td>Tx Bandwidth</td>
<td>#</td>
<td>Reports the packets sent from the processor to the Ethernet links on the specified NET port</td>
</tr>
</tbody>
</table>
Figure 43  Diagnostics — Video Output Stream
Technical Specifications

This chapter provides technical information for NEWT-IPX.

* Specifications are subject to change without notice.

Supported Video Formats

<table>
<thead>
<tr>
<th>Resolution (lines)</th>
<th>SDI Mode</th>
<th>HDMI Mode</th>
</tr>
</thead>
<tbody>
<tr>
<td>720p 50Hz</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>720p 59.94Hz</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>720p 60Hz</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>1080i 50</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>1080i 59.94</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>1080i 60</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>1080p 50</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>1080p 59.94</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>1080p 60</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>2160p 25</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>2160p 29.94</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>2160p 30</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>2160p 50</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>2160p 59.94</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>2160p 60</td>
<td>✓</td>
<td></td>
</tr>
</tbody>
</table>

NET 1, 2 Ports - Single Mode Connections

The NET ports on the NEWT-IPX can be populated with the following classes of modules.

Transmitter Port

<table>
<thead>
<tr>
<th>Item</th>
<th>Specifications</th>
</tr>
</thead>
<tbody>
<tr>
<td>Port Type</td>
<td>10GBASE-LR</td>
</tr>
<tr>
<td>Signaling Speed</td>
<td>10.3125Gbps</td>
</tr>
<tr>
<td>Center Wavelength (typical)</td>
<td>1310nm</td>
</tr>
<tr>
<td>OMA Output Power (min.)</td>
<td>-5.2dBm</td>
</tr>
<tr>
<td>Extinction Ratio (min.)</td>
<td>3.5dB</td>
</tr>
<tr>
<td>Side Mode Suppression Ratio - SMSR (min.)</td>
<td>30dB</td>
</tr>
</tbody>
</table>
### Receiver Port

Table 29 Technical Specifications — Single-mode Receiver Port

<table>
<thead>
<tr>
<th>Item</th>
<th>Specifications</th>
</tr>
</thead>
<tbody>
<tr>
<td>Port Type</td>
<td>10GBASE-LR</td>
</tr>
<tr>
<td>Signaling Speed</td>
<td>10.3125Gbps</td>
</tr>
<tr>
<td>Center Wavelength</td>
<td>1310nm</td>
</tr>
<tr>
<td>Overload (min.)</td>
<td>0.5dBm</td>
</tr>
<tr>
<td>Receiver Sensitivity in OMA (max.)</td>
<td>-12.6dBm</td>
</tr>
<tr>
<td>Stressed Receive Sensitivity OMA (max.)</td>
<td>-10.3dBm</td>
</tr>
<tr>
<td>Link Length (max.)</td>
<td>10km</td>
</tr>
<tr>
<td>Connector Type</td>
<td>Single-mode fiber</td>
</tr>
<tr>
<td></td>
<td>Standard LC duplex fiber-optic connector</td>
</tr>
</tbody>
</table>

NET 1, 2 Ports - Multi-mode Connections

Transmitter

Table 30 Technical Specifications — Multi-mode Transmitter Port

<table>
<thead>
<tr>
<th>Item</th>
<th>Specifications</th>
</tr>
</thead>
<tbody>
<tr>
<td>Port Type</td>
<td>10GBASE-SR</td>
</tr>
<tr>
<td>Signaling Speed</td>
<td>10.3125Gbps</td>
</tr>
<tr>
<td>Signaling Speed Variation from Normal</td>
<td>+/-100ppm</td>
</tr>
<tr>
<td>Center Wavelength (typical)</td>
<td>850nm</td>
</tr>
<tr>
<td>Spectral Width RMS (max.)</td>
<td>0.65nm</td>
</tr>
<tr>
<td>Average Output Power (min.)</td>
<td>-5dBm</td>
</tr>
<tr>
<td>Extinction Ratio (min.)</td>
<td>3</td>
</tr>
<tr>
<td>Optical Return Loss (max.)</td>
<td>12dB</td>
</tr>
<tr>
<td>Connector Type</td>
<td>Multi-mode fiber</td>
</tr>
<tr>
<td></td>
<td>Standard LC duplex fiber-optic connector</td>
</tr>
</tbody>
</table>
### Receiver

**Table 31 Technical Specifications — Multi-mode Receiver Port**

<table>
<thead>
<tr>
<th>Item</th>
<th>Specifications</th>
</tr>
</thead>
<tbody>
<tr>
<td>Port Type</td>
<td>10GBASE-SR</td>
</tr>
<tr>
<td>Signaling Speed</td>
<td>10.3125Gbps</td>
</tr>
<tr>
<td>Signaling Speed Variation from Nominal</td>
<td>+/-100ppm</td>
</tr>
<tr>
<td>Center Wavelength</td>
<td>850nm</td>
</tr>
<tr>
<td>Overload (min.)</td>
<td>0dBm</td>
</tr>
<tr>
<td>Receiver Sensitivity in OMA (max.)</td>
<td>-11dBm</td>
</tr>
<tr>
<td>Stressed Receive Sensitivity OMA (max.)</td>
<td>-7.5dBm</td>
</tr>
<tr>
<td>Connector Type</td>
<td>Multi-mode fiber</td>
</tr>
<tr>
<td></td>
<td>Standard LC duplex fiber-optic connector</td>
</tr>
</tbody>
</table>

### Multi-mode Fiber Link Length

**Table 32 Multi-mode Fiber Link Length**

<table>
<thead>
<tr>
<th>Fiber Type</th>
<th>Category</th>
<th>Minimum Modal Bandwidth @ 850nm (MHz*km)</th>
<th>Operating Range (m)</th>
</tr>
</thead>
<tbody>
<tr>
<td>62.5um MMF</td>
<td>FDDI</td>
<td>160</td>
<td>2-26</td>
</tr>
<tr>
<td></td>
<td>OM1</td>
<td>200</td>
<td>2-33</td>
</tr>
<tr>
<td>50um MMF</td>
<td>OM2</td>
<td>500</td>
<td>2-83</td>
</tr>
<tr>
<td></td>
<td>OM3</td>
<td>2000</td>
<td>2-300</td>
</tr>
</tbody>
</table>

### CONTROL Port

**Table 33 Technical Specifications — Control Port**

<table>
<thead>
<tr>
<th>Item</th>
<th>Specifications</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of CONTROL Ports</td>
<td>1</td>
</tr>
<tr>
<td>Standards Accommodated</td>
<td>10/100/1000BASE-T</td>
</tr>
<tr>
<td>Connector Type</td>
<td>RJ45</td>
</tr>
</tbody>
</table>

### SDI Outputs Specifications

**Table 34 Technical Specifications — SDI Outputs**

<table>
<thead>
<tr>
<th>Item</th>
<th>Specifications</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of Outputs</td>
<td>Up to 4 (user configurable)</td>
</tr>
<tr>
<td>Standards Accommodated</td>
<td>SMPTE ST 2082-1</td>
</tr>
<tr>
<td>Impedance</td>
<td>75ohm</td>
</tr>
</tbody>
</table>
### HDMI Port Specifications

* The HDMI port is not implemented.

<table>
<thead>
<tr>
<th>Item</th>
<th>Specifications</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of Outputs</td>
<td>1 (user configurable)</td>
</tr>
<tr>
<td>HDMI Version</td>
<td>2.0</td>
</tr>
<tr>
<td>Output Color Space</td>
<td>YCbCr 4:2:2</td>
</tr>
<tr>
<td>Connector Type</td>
<td>Type A</td>
</tr>
</tbody>
</table>

### Power

<table>
<thead>
<tr>
<th>Item</th>
<th>Specifications</th>
</tr>
</thead>
<tbody>
<tr>
<td>Required Voltage</td>
<td>15V</td>
</tr>
<tr>
<td>Current Consumption</td>
<td>1-2.67A</td>
</tr>
<tr>
<td>Total Power Consumption</td>
<td>15-40W (application dependent)</td>
</tr>
</tbody>
</table>

### Environment

<table>
<thead>
<tr>
<th>Item</th>
<th>Specifications</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum Ambient Temperature</td>
<td>40°C (104°F)</td>
</tr>
</tbody>
</table>
## Dimensions

*Table 38 Technical Specifications — Dimensions*

<table>
<thead>
<tr>
<th>Item</th>
<th>Specifications</th>
</tr>
</thead>
<tbody>
<tr>
<td>Physical Dimensions</td>
<td>4.98” x 6.75” x 1.63”</td>
</tr>
<tr>
<td>Weight</td>
<td>815g (1.8lb)</td>
</tr>
</tbody>
</table>
Service Information

This chapter provides information on the warranty and repair policy for your NEWT-IPX.

Troubleshooting Checklist

Routine maintenance to this Ross product is not required. In the event of problems with your NEWT-IPX, the following basic troubleshooting checklist may help identify the source of the problem. If the NEWT-IPX still does not appear to be working properly after checking all possible causes, please contact your Ross products distributor, or the Technical Support department at the numbers listed in “Contacting Technical Support”.

1. Visual Review — Performing a quick visual check may reveal many problems, such as connectors not properly seated or loose cables. Check the NEWT-IPX and any associated peripheral equipment for signs of trouble.

2. Power Check — Verify the PWR LED on the NEWT-IPX chassis for the presence of power. If the PWR LED is not illuminated, verify that the power cable is connected to a power source and that power is available at the power main. If the PWR LED is still not illuminated, replace the power supply with one that is verified to work.

3. Input Signal Status — Verify that source equipment is operating correctly and that a valid signal is supplied.

4. Output Signal Path — Verify that destination equipment is operating correctly and receiving a valid signal.

5. Module Exchange — Exchanging a suspect module with a module that is known to be working correctly is an efficient method for localizing problems to individual modules.

6. Re-load the Factory Defaults — If the module appears to be working and reports no errors, but is not generating an active picture or outputs black, restoring the default factory configuration may fix the problem.

★ Contact Ross Technical Support if the NEWT-IPX is non-responsive after an upgrade.

Warranty and Repair Policy

The NEWT-IPX is warranted to be free of any defect with respect to performance, quality, reliability, and workmanship for a period of ONE (1) year from the date of delivery to the customer. In the event that your NEWT-IPX proves to be defective in any way during this warranty period, Ross Video Limited reserves the right to repair or replace this piece of equipment with a unit of equal or superior performance characteristics.

Should you find that this NEWT-IPX has failed after your warranty period has expired, we will repair your defective product should suitable replacement components be available. You, the owner, will bear any labor and/or part costs incurred in the repair or refurbishment of said equipment beyond the ONE (1) year warranty period.

In no event shall Ross Video Limited be liable for direct, indirect, special, incidental, or consequential damages (including loss of profits) incurred by the use of this product. Implied warranties are expressly limited to the duration of this warranty.

This NEWT-IPX User Guide provides all pertinent information for the safe installation and operation of your NEWT-IPX. Ross Video policy dictates that all repairs to the NEWT-IPX are to be conducted only by an authorized Ross Video Limited factory representative. Therefore, any unauthorized attempt to repair this product, by anyone other than an authorized Ross Video Limited factory representative, will automatically void the warranty. Please contact Ross Video Technical Support for more information.
In Case of Problems

Should any problem arise with your NEWT-IPX, please contact the Ross Video Technical Support Department. (Contact information is supplied at in the section “Contacting Technical Support”.)

A Return Material Authorization number (RMA) will be issued to you, as well as specific shipping instructions, should you wish our factory to repair your NEWT-IPX. If required, a temporary replacement will be made available at a nominal charge. Any shipping costs incurred will be the responsibility of you, the customer. All products shipped to you from Ross Video Limited will be shipped collect.

The Ross Video Technical Support Department will continue to provide advice on any product manufactured by Ross Video Limited, beyond the warranty period without charge, for the life of the equipment.
Software Licenses

This chapter provides third-party software license information for your NEWT-IPX. This product includes multiple software components which are individually licensed under one or more of the following licenses included in this chapter.

BSD

Copyright (c) 1991,1993, The Regents of the University of California. All rights reserved.

This code is derived from software contributed to Berkeley by Kenneth Almquist.

 Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution.


4. Neither the name of the University nor the names of its contributors may be used to endorse or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE REGENTS AND CONTRIBUTORS `AS IS' AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE REGENTS OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Dual GPL

Portions of this software are copyright (C) 1996-2002 The FreeType Project (www.freetype.org). All rights reserved.

This project is also covered under the GPL v2.

GPL

GNU GENERAL PUBLIC LICENSE
Version 3, 29 June 2007
Copyright (C) 2007 Free Software Foundation, Inc. <http://fsf.org/>
Preamble

The GNU General Public License is a free, copyleft license for software and other kinds of works.

The licenses for most software and other practical works are designed to take away your freedom to share and change the works. By contrast, the GNU General Public License is intended to guarantee your freedom to share and change all versions of a program--to make sure it remains free software for all its users. We, the Free Software Foundation, use the GNU General Public License for most of our software; it applies also to any other work released this way by its authors. You can apply it to your programs, too.

When we speak of free software, we are referring to freedom, not price. Our General Public Licenses are designed to make sure that you have the freedom to distribute copies of free software (and charge for them if you wish), that you receive source code or can get it if you want it, that you can change the software or use pieces of it in new free programs, and that you know you can do these things.

To protect your rights, we need to prevent others from denying you these rights or asking you to surrender the rights. Therefore, you have certain responsibilities if you distribute copies of the software, or if you modify it: responsibilities to respect the freedom of others.

For example, if you distribute copies of such a program, whether gratis or for a fee, you must pass on to the recipients the same freedoms that you received. You must make sure that they, too, receive or can get the source code. And you must show them these terms so they know their rights.

Developers that use the GNU GPL protect your rights with two steps: (1) assert copyright on the software, and (2) offer you this License giving you legal permission to copy, distribute and/or modify it.

For the developers' and authors' protection, the GPL clearly explains that there is no warranty for this free software. For both users' and authors' sake, the GPL requires that modified versions be marked as changed, so that their problems will not be attributed erroneously to authors of previous versions.

Some devices are designed to deny users access to install or run modified versions of the software inside them, although the manufacturer can do so. This is fundamentally incompatible with the aim of protecting users' freedom to change the software. The systematic pattern of such abuse occurs in the area of products for individuals to use, which is precisely where it is most unacceptable. Therefore, we have designed this version of the GPL to prohibit the practice for those products. If
such problems arise substantially in other domains, we stand ready to extend this provision to those domains in future versions of the GPL, as needed to protect the freedom of users.

Finally, every program is threatened constantly by software patents. States should not allow patents to restrict development and use of software on general-purpose computers, but in those that do, we wish to avoid the special danger that patents applied to a free program could make it effectively proprietary. To prevent this, the GPL assures that patents cannot be used to render the program non-free.

The precise terms and conditions for copying, distribution and modification follow.

TERMS AND CONDITIONS

0. Definitions.

"This License" refers to version 3 of the GNU General Public License.

"Copyright" also means copyright-like laws that apply to other kinds of works, such as semiconductor masks.

"The Program" refers to any copyrightable work licensed under this License. Each licensee is addressed as "you", "Licensees" and "recipients" may be individuals or organizations.

To "modify" a work means to copy from or adapt all or part of the work in a fashion requiring copyright permission, other than the making of an exact copy. The resulting work is called a "modified version" of the earlier work or a work "based on" the earlier work.

A "covered work" means either the unmodified Program or a work based on the Program.

To "propagate" a work means to do anything with it that, without permission, would make you directly or secondarily liable for infringement under applicable copyright law, except executing it on a computer or modifying a private copy. Propagation includes copying, distribution (with or without modification), making available to the public, and in some countries other activities as well.

To "convey" a work means any kind of propagation that enables other parties to make or receive copies. Mere interaction with a user through a computer network, with no transfer of a copy, is not conveying.

An interactive user interface displays "Appropriate Legal Notices" to the extent that it includes a convenient and prominently visible feature that (1) displays an appropriate copyright notice, and (2) tells the user that there is no warranty for the work (except to the extent that warranties are provided), that licensees may convey the work under this License, and how to view a copy of this License. If the interface presents a list of user commands or options, such as a menu, a prominent item in the list meets this criterion.


The "source code" for a work means the preferred form of the work for making modifications to it. "Object code" means any non-source form of a work.

A "Standard Interface" means an interface that either is an official standard defined by a recognized standards body, or, in the case of interfaces specified for a particular programming language, one that is widely used among developers working in that language.

The "System Libraries" of an executable work include everything, other than the work as a whole, that (a) is included in the normal form of packaging a Major Component, and (b) serves only to enable use of the work with that Major Component, or to implement a Standard Interface for which an implementation is available to the public in source code form. A "Major Component", in this context, means a major essential component (kernel, window system, and so on) of the specific operating system (if any) on which the executable work runs, or a compiler used to produce the work, or an object code interpreter used to run it.

The "Corresponding Source" for a work in object code form means all the source code needed to generate, install, and (for an executable work) run the object code and to modify the work, including scripts to control those activities. However, it does not include the work's System Libraries, or general-purpose tools or generally available free programs which are used unmodified in performing those activities but which are not part of the work. For example, Corresponding Source includes interface definition files associated with source files for the work, and the source code for shared libraries and dynamically linked subprograms that the work is specifically designed to require, such as by intimate data communication or control flow between those subprograms and other parts of the work.

The Corresponding Source need not include anything that users can regenerate automatically from other parts of the Corresponding Source.

The Corresponding Source for a work in source code form is that same work.

2. Basic Permissions.

All rights granted under this License are granted for the term of copyright on the Program, and are irrevocable provided the stated conditions are met. This License explicitly affirms your unlimited permission to run the unmodified Program. The output from running a covered work is covered by this License only if the output, given its content, constitutes a covered work. This License acknowledges your rights of fair use or other equivalent, as provided by copyright law.

You may make, run and propagate covered works that you do not convey, without conditions so long as your license otherwise remains in force. You may convey covered works to others for the sole purpose of having them make modifications exclusively for you, or provide you with facilities for running those works, provided that you comply with the terms of this License in conveying all material for which you do not control copyright. Those thus making or running the covered works for you must do so exclusively on your behalf, under your direction and control, on terms that prohibit them from making any copies of your copyrighted material outside their relationship with you.

Conveying under any other circumstances is permitted solely under the conditions stated below: Sublicensing is not allowed; section 10 makes it unnecessary.

3. Protecting Users' Legal Rights From Anti-Circumvention Law.

No covered work shall be deemed part of an effective technological measure under any applicable law fulfilling obligations under article 11 of the WIPO copyright treaty adopted on 20 December 1996, or similar laws prohibiting or restricting circumvention of such measures.

When you convey a covered work, you waive any legal power to forbid circumvention of technological measures to the extent such circumvention is effected by exercising rights under this License with respect to the covered work, and you disclaim any intention to limit operation or modification of the work as a means of enforcing, against the work's users, your or third parties' legal rights to forbid circumvention of technological measures.
You may convey verbatim copies of the Program's source code as you receive it, in any medium, provided that you conspicuously and appropriately publish on each copy an appropriate copyright notice; keep intact all notices stating that this License and any non-permissive terms added in accord with section 7 apply to the code; keep intact all notices of the absence of any warranty; and give all recipients a copy of this License along with the Program.
You may charge any price or no price for each copy that you convey, and you may offer support or warranty protection for a fee.

5. Conveying Modified Source Versions.
You may convey a work based on the Program, or the modifications to produce it from the Program, in the form of source code under the terms of section 4, provided that you also meet all of these conditions:
- a. The work must carry prominent notices stating that you modified it, and giving a relevant date.
- b. The work must carry prominent notices stating that it is released under this License and any conditions added under section 7. This requirement modifies the requirement in section 4 to "keep intact all notices".
- c. You must license the entire work, as a whole, under this License to anyone who comes into possession of a copy. This License will therefore apply, along with any applicable section 7 additional terms, to the whole of the work, and all its parts, regardless of how they are packaged. This License gives no permission to license the work in any other way, but it does not invalidate such permission if you have separately received it.
- d. If the work has interactive user interfaces, each must display Appropriate Legal Notices; however, if the Program has interactive interfaces that do not display Appropriate Legal Notices, your work need not make them do so.

A compilation of a covered work with other separate and independent works, which are not by their nature extensions of the covered work, and which are not combined with it such as to form a larger program, in or on a volume of a storage or distribution medium, is called an "aggregate" if the compilation and its resulting copyright are not used to limit the access or legal rights of the compilation's users beyond what the individual works permit. Inclusion of a covered work in an aggregate does not cause this License to apply to the other parts of the aggregate.

6. Conveying Non-Source Forms.
You may convey a covered work in object code form under the terms of sections 4 and 5, provided that you also convey the machine-readable Corresponding Source under the terms of this License, in one of these ways:
- a. Convey the object code in, or embodied in, a physical product (including a physical distribution medium), accompanied by the Corresponding Source fixed on a durable physical medium customarily used for software interchange.
- b. Convey the object code in, or embodied in, a physical product (including a physical distribution medium), accompanied by a written offer, valid for at least three years and valid for as long as you offer spare parts or customer support for that product model, to give anyone who possesses the object code either (1) a copy of the Corresponding Source for all the software in the product that is covered by this License, on a durable physical medium customarily used for software interchange, for a price no more than your reasonable cost of physically performing this conveying of source, or (2) access to copy the Corresponding Source from a network server at no charge.
- c. Convey individual copies of the object code with a copy of the written offer to provide the Corresponding Source. This alternative is allowed only occasionally and noncommercially, and only if you received the object code with such an offer, in accord with subsection 6b.
- d. Convey the object code by offering access from a designated place (gratis or for a charge), and offer equivalent access to the Corresponding Source in the same way through the same place at no further charge. You need not require recipients to copy the Corresponding Source along with the object code. If the place to copy the object code is a network server, the Corresponding Source may be on a different server (operated by you or a third party) that supports equivalent copying facilities, provided you maintain clear directions next to the object code saying where to find the Corresponding Source. Regardless of what server hosts the Corresponding Source, you remain obligated to ensure that it is available for as long as needed to satisfy these requirements.
- e. Convey the object code using peer-to-peer transmission, provided you inform other peers where the object code and Corresponding Source of the work are being offered to the general public at no charge under subsection 6d.

A separable portion of the object code, whose source code is excluded from the Corresponding Source as a System Library, need not be included in conveying the object code work.

A "User Product" is either (1) a "consumer product", which means any tangible personal property which is normally used for personal, family, or household purposes, or (2) anything designed or sold for incorporation into a dwelling. In determining whether a product is a consumer product, doubtful cases shall be resolved in favor of coverage. For a particular product received by a particular user, "normally used" refers to a typical or common use of that class of product, regardless of the status of the particular user or of the way in which the particular user actually uses, or expects or is expected to use, the product. A product is a consumer product regardless of whether the product has substantial commercial, industrial or non-consumer uses, unless such uses represent the only significant mode of use of the product.

"Installation Information" for a User Product means any methods, procedures, authorization keys, or other information required to install and execute modified versions of a covered work in that User Product from a modified version of its Corresponding Source. The information must suffice to ensure that the continued functioning of the modified object code is in no case prevented or interfered with solely because modification has been made.

If you convey an object code work under this section in, or with, or specifically for use in, a User Product, and the conveying occurs as part of a transaction in which the right of possession and use of the User Product is transferred to the recipient in perpetuity or for a fixed term (regardless of how the transaction is characterized), the Corresponding Source conveyed under this section must be accompanied by the Installation Information. But this requirement does not apply if neither you nor any third party retains the ability to install modified object code on the User Product (for example, the work has been installed in ROM).

The requirement to provide Installation Information does not include a requirement to continue to provide support service, warranty, or updates for a work that has been modified or installed by the recipient, or for the User Product in which it has been modified or installed. Access to a network may be denied when the modification itself materially and adversely affects the operation of the network or violates the rules and protocols for communication across the network.

Corresponding Source conveyed, and Installation Information provided, in accord with this section must be in a format that is publicly documented (and with an implementation available to the public in source code form), and must require no special password or key for unpacking, reading or copying.

7. Additional Terms.
"Additional permissions" are terms that supplement the terms of this License by making exceptions from one or more of its conditions. Additional permissions that are applicable to the entire Program shall be treated as though they were included in this License, to the extent that they are valid under applicable law. If additional permissions apply only to part of the Program, that part may be used separately under those permissions, but the entire Program remains governed by this License without regard to the additional permissions.
When you convey a copy of a covered work, you may at your option remove any additional permissions from that copy, or from any part of it. (Additional permissions may be written to require their own removal in certain cases when you modify the work.) You may place additional permissions on material, added by you to a covered work, for which you have or can give appropriate copyright permission.

Notwithstanding any other provision of this License, for material you add to a covered work, you may (if authorized by the copyright holders of that material) supplement the terms of this License with terms:

a. Disclaiming warranty or limiting liability differently from the terms of sections 15 and 16 of this License; or
b. Requiring preservation of specified reasonable legal notices or author attributions in that material or in the Appropriate Legal Notices displayed by works containing it; or
c. Prohibiting misrepresentation of the origin of that material, or requiring that modified versions of such material be marked in reasonable ways as different from the original version; or
d. Limiting the use for publicity purposes of names of licensors or authors of the material; or
e. Declining to grant rights under trademark law for use of some trade names, trademarks, or service marks; or
f. Requiring indemnification of licensors and authors of that material by anyone who conveys the material (or modified versions of it) with contractual assumptions of liability to the recipient, for any liability that these contractual assumptions directly impose on those licensors and authors.

All other non-permissive additional terms are considered "further restrictions" within the meaning of section 10. If the Program as you received it, or any part of it, contains a notice stating that it is governed by this License along with a term that is a further restriction, you may remove that term. If a license document contains a further restriction but permits relicensing or conveying under this License, you may add to a covered work material governed by the terms of that license document, provided that the further restriction does not survive such relicensing or conveying.

If you add terms to a covered work in accord with this section, you must place, in the relevant source files, a statement of the additional terms that apply to those files, or a notice indicating where to find the applicable terms.

Additional terms, permissive or non-permissive, may be stated in the form of a separately written license, or stated as exceptions; the above requirements apply either way.

8. Termination.

You may not propagate or modify a covered work except as expressly provided under this License. Any attempt otherwise to propagate or modify it is void, and will automatically terminate your rights under this License (including any patent licenses granted under the third paragraph of section 11).

However, if you cease all violation of this License, then your license from a particular copyright holder is reinstated (a) provisionally, unless and until the copyright holder explicitly and finally terminates your license, and (b) permanently, if the copyright holder fails to notify you of the violation by some reasonable means prior to 60 days after the cessation.

Moreover, your license from a particular copyright holder is reinstated permanently if the copyright holder notifies you of the violation by some reasonable means, this is the first time you have received notice of violation of this License (for any work) from that copyright holder, and you cure the violation prior to 30 days after your receipt of the notice.

Termination of your rights under this section does not terminate the licenses of parties who have received copies or rights from you under this License. If your rights have been terminated and not permanently reinstated, you do not qualify to receive new licenses for the same material under section 10.


You are not required to accept this License in order to receive or run a copy of the Program. Ancillary propagation of a covered work occurring solely as a consequence of using peer-to-peer transmission to receive a copy likewise does not require acceptance. However, nothing other than this License grants you permission to propagate or modify any covered work. These actions infringe copyright if you do not accept this License. Therefore, by modifying or propagating a covered work, you indicate your acceptance of this License to do so.

10. Automatic Licensing of Downstream Recipients.

Each time you convey a covered work, the recipient automatically receives a license from the original licensors, to run, modify and propagate that work, subject to this License. You are not responsible for enforcing compliance by third parties with this License.

An "entity transaction" is a transaction transferring control of an organization, or substantially all assets of one, or subdividing an organization, or merging organizations. If propagation of a covered work results from an entity transaction, each party to that transaction who receives a copy of the work also receives whatever licenses to the work the party's predecessor in interest had or could give under the previous paragraph, plus a right to possession of the Corresponding Source of the work from the predecessor in interest, if the predecessor has it or can get it with reasonable efforts.

You may not impose any further restrictions on the exercise of the rights granted or affirmed under this License. For example, you may not impose a license fee, royalty, or other charge for exercise of rights granted under this License, and you may not initiate litigation (including a cross-claim or counterclaim in a lawsuit) alleging that any patent claim is infringed by making, using, selling, offering for sale, or importing the Program or any portion of it.

11. Patents.

A "contributor" is a copyright holder who authorizes use under this License of the Program or a work on which the Program is based. The work thus licensed is called the contributor's "contributor version".

A contributor's "essential patent claims" are all patent claims owned or controlled by the contributor, whether already acquired or hereafter acquired, that would be infringed by some manner, permitted by this License, of making, using, selling, offering for sale, or importing the Program or any part of it.

In the following three paragraphs, a "patent license" is any express agreement or commitment, however denominated, not to enforce a patent (such as an express permission to practice a patent or covenant not to sue for patent infringement). To "grant" such a patent license to a party means to make such an agreement or commitment not to enforce a patent against the party.
If you convey a covered work, knowingly relying on a patent license, and the Corresponding Source of the work is not available for anyone to copy, free of charge and under the terms of this License, through a publicly available network server or other readily accessible means, then you must either (1) cause the Corresponding Source to be so available, or (2) arrange to deprive yourself of the benefit of the patent license for this particular work, or (3) arrange, in a manner consistent with the requirements of this License, to extend the patent license to downstream recipients. "Knowingly relying" means you have actual knowledge that, but for the patent license, your conveying the covered work in a country, or your recipient's use of the covered work in a country, would infringe one or more identifiable patents in that country that you have reason to believe are valid.

If, pursuant to or in connection with a single transaction or arrangement, you convey, or propagate by procuring conveyance of, a covered work, and grant a patent license to some of the parties receiving the covered work authorizing them to use, propagate, modify or convey a specific copy of the covered work, then the patent license you grant is automatically extended to all recipients of the covered work and works based on it.

A patent license is "discriminatory" if it does not include within the scope of its coverage, prohibits the exercise of, or is conditioned on the non-exercise of one or more of the rights that are specifically granted under this License. You may not convey a covered work if you are a party to an arrangement with a third party that is in the business of distributing software, under which you make payment to the third party based on the extent of your activity of conveying the work, and under which the third party grants, to any of the parties who would receive the covered work from you, a discriminatory patent license (a) in connection with copies of the covered work conveyed by you (or copies made from those copies), or (b) primarily for and in connection with specific products or compilations that contain the covered work, unless you entered into that arrangement, or that patent license was granted, prior to 28 March 2007.

Nothing in this License shall be construed as excluding or limiting any implied license or other defenses to infringement that may otherwise be available to you under applicable patent law.


If conditions are imposed on you (whether by court order, agreement or otherwise) that contradict the conditions of this License, they do not excuse you from the conditions of this License. If you cannot convey a covered work so as to satisfy simultaneously your obligations under this License and any other pertinent obligations, then as a consequence you may not convey it at all. For example, if you agree to terms that obligate you to collect a royalty for further conveying from those to whom you convey the Program, the only way you could satisfy both those terms and this License would be to refrain entirely from conveying the Program.

13. Use with the GNU Affero General Public License.

Notwithstanding any other provision of this License, you have permission to link or combine any covered work with a work licensed under version 3 of the GNU Affero General Public License into a single combined work, and to convey the resulting work. The terms of this License will continue to apply to the part which is the covered work, but the special requirements of the GNU Affero General Public License, section 13, concerning interaction through a network will apply to the combination as such.

14. Revised Versions of this License.

The Free Software Foundation may publish revised and/or new versions of the GNU General Public License from time to time. Such new versions will be similar in spirit to the present version, but may differ in detail to address new problems or concerns.

Each version is given a distinguishing version number. If the Program specifies that a certain numbered version of the GNU General Public License "or any later version" applies to it, you have the option of following the terms and conditions either of that numbered version or of any later version published by the Free Software Foundation. If the Program does not specify a version number of the GNU General Public License, you may choose any version ever published by the Free Software Foundation.

If the Program specifies that a proxy can decide which future versions of the GNU General Public License can be used, that proxy's public statement of acceptance of a version permanently authorizes you to choose that version for the Program.

Later license versions may give you additional or different permissions. However, no additional obligations are imposed on any author or copyright holder as a result of your choosing to follow a later version.

15. Disclaimer of Warranty.

THERE IS NO WARRANTY FOR THE PROGRAM, TO THE EXTENT PERMITTED BY APPLICABLE LAW. EXCEPT WHEN OTHERWISE STATED IN WRITING THE COPYRIGHT HOLDERS AND/OR OTHER PARTIES PROVIDE THE PROGRAM "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. THE ENTIRE RISK AS TO THE QUALITY AND PERFORMANCE OF THE PROGRAM IS WITH YOU. SHOULD THE PROGRAM PROVE DEFECTIVE, YOU ASSUME THE COST OF ALL NECESSARY SERVICING, REPAIR OR CORRECTION.

16. Limitation of Liability.

IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO IN WRITING WILL ANY COPYRIGHT HOLDER, OR ANY OTHER PARTY WHO MODIFIES AND/OR CONVEYS THE PROGRAM AS PERMITTED ABOVE, BE LIABLE TO YOU FOR DAMAGES, INCLUDING ANY GENERAL, SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OR INABILITY TO USE THE PROGRAM (INCLUDING BUT NOT LIMITED TO LOSS OF DATA OR DATA BEING RENDERED INACCURATE OR LOSSES SUSTAINED BY YOU OR THIRD PARTIES OR A FAILURE OF THE PROGRAM TO OPERATE WITH ANY OTHER PROGRAMS), EVEN IF SUCH HOLDER OR OTHER PARTY HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

17. Interpretation of Sections 15 and 16.

If the disclaimer of warranty and limitation of liability provided above cannot be given local legal effect according to their terms, reviewing courts shall apply local law that most closely approximates an absolute waiver of all civil liability in connection with the Program, unless a warranty or assumption of liability accompanies a copy of the Program in return for a fee.
**LGPL**

GNU LESSER GENERAL PUBLIC LICENSE
Version 3, 29 June 2007
Copyright (C) 2007 Free Software Foundation, Inc. <http://fsf.org/>

Everyone is permitted to copy and distribute verbatim copies of this license document, but changing it is not allowed.

This version of the GNU Lesser General Public License incorporates the terms and conditions of version 3 of the GNU General Public License, supplemented by the additional permissions listed below:

0. Additional Definitions.

As used herein, "this License" refers to version 3 of the GNU Lesser General Public License, and the "GNU GPL" refers to version 3 of the GNU General Public License.

"The Library" refers to a covered work governed by this License, other than an Application or a Combined Work as defined below.

An "Application" is any work that makes use of an interface provided by the Library, but which is not otherwise based on the Library. Defining a subclass of a class defined by the Library is deemed a mode of using an interface provided by the Library.

A "Combined Work" is a work produced by combining or linking an Application with the Library. The particular version of the Library with which the Combined Work was made is also called the "Linked Version".

The "Minimal Corresponding Source" for a Combined Work means the Corresponding Source for the Combined Work, excluding any source code for portions of the Combined Work that, considered in isolation, are based on the Application, and not on the Linked Version.

The "Corresponding Application Code" for a Combined Work means the object code and/or source code for the Application, including any data and utility programs needed for reproducing the Combined Work from the Application, but excluding the System Libraries of the Combined Work.

1. Exception to Section 3 of the GNU GPL.

You may convey a covered work under sections 3 and 4 of this License without being bound by section 3 of the GNU GPL.

2. Conveying Modified Versions.

If you modify a copy of the Library, and, in your modifications, a facility refers to a function or data to be supplied by an Application that uses the facility (other than as an argument passed when the facility is invoked), then you may convey a copy of the modified version:

a. under this License, provided that you make a good faith effort to ensure that, in the event an Application does not supply the function or data, the facility still operates, and performs whatever part of its purpose remains meaningful, or

b. under the GNU GPL, with none of the additional permissions of this License applicable to that copy.


The object code form of an Application may incorporate material from a header file that is part of the Library. You may convey such object code under terms of your choice, provided that, if the incorporated material is not limited to numerical parameters, data structure layouts and accessors, or small macros, inline functions and templates (ten or fewer lines in length), you do both of the following:

a. Give prominent notice with each copy of the object code that the Library is used in it and that the Library and its use are covered by this License.

b. Accompany the object code with a copy of the GNU GPL and this license document.


You may convey a Combined Work under terms of your choice that, taken together, effectively do not restrict modification of the portions of the Library contained in the Combined Work and reverse engineering for debugging such modifications, if you also do each of the following:

a. Give prominent notice with each copy of the Combined Work that the Library is used in it and that the Library and its use are covered by this License.

b. Accompany the Combined Work with a copy of the GNU GPL and this license document.

c. For a Combined Work that displays copyright notices during execution, include the copyright notice for the Library among these notices, as well as a reference directing the user to the copies of the GNU GPL and this license document.

d. Do one of the following:

1) Convey the Minimal Corresponding Source under the terms of this License, and the Corresponding Application Code in a form suitable for, and under terms that permit, the user to recombine or relink the Application with a modified version of the Linked Version to produce a modified Combined Work, in the manner specified by section 6 of the GNU GPL for conveying Corresponding Source.

2) Use a suitable shared library mechanism for linking with the Library. A suitable mechanism is one that (a) uses at run time a copy of the Library already present on the user's computer system, and (b) will operate properly with a modified version of the Library that is interface-compatible with the Linked Version.

e. Provide Installation Information, but only if you would otherwise be required to provide such information under section 6 of the GNU GPL, and only to the extent that such information is necessary to install and execute a modified version of the Combined Work produced by recombining or relinking the Application with a modified version of the Linked Version. (If you use option 4d0, the Installation Information must accompany the Minimal Corresponding Source and Corresponding Application Code. If you use option 4d1, you must provide the Installation Information in the manner specified by section 6 of the GNU GPL for conveying Corresponding Source.)


You may place library facilities that are a work based on the Library side by side in a single library together with other library facilities that are not Applications and are not covered by this License, and convey such a combined library under terms of your choice, if you do both of the following:
a. Accompany the combined library with a copy of the same work based on the Library, uncombined with any other library facilities, conveyed under the terms of this License.

b. Give prominent notice with the combined library that part of it is a work based on the Library, and explaining where to find the accompanying uncombined form of the same work.

6. Revised Versions of the GNU Lesser General Public License.

The Free Software Foundation may publish revised and/or new versions of the GNU Lesser General Public License from time to time. Such new versions will be similar in spirit to the present version, but may differ in detail to address new problems or concerns.

Each version is given a distinguishing version number. If the Library as you received it specifies that a certain numbered version of the GNU Lesser General Public License "or any later version" applies to it, you have the option of following the terms and conditions either of that published version or of any later version published by the Free Software Foundation. If the Library as you received it does not specify a version number of the GNU Lesser General Public License, you may choose any version of the GNU Lesser General Public License ever published by the Free Software Foundation.

If the Library as you received it specifies that a proxy can decide whether future versions of the GNU Lesser General Public License shall apply, that proxy's public statement of acceptance of any version is permanent authorization for you to choose that version for the Library.

MIT

Copyright 1987, 1988 by MIT Student Information Processing Board.

Permission to use, copy, modify, and distribute this software and its documentation for any purpose is hereby granted, provided that the names of M.I.T. and the M.I.T. S.I.P.B. not be used in advertising or publicity pertaining to distribution of the software without specific, written prior permission. M.I.T. and the M.I.T. S.I.P.B. make no representations about the suitability of this software for any purpose. It is provided "as is" without express or implied warranty.

zlib

Copyright (C) 1995-1998 Jean-loup Gailly and Mark Adler

This software is provided 'as-is', without any express or implied warranty. In no event will the authors be held liable for any damages arising from the use of this software.

Permission is granted to anyone to use this software for any purpose, including commercial applications, and to alter it and redistribute it freely, subject to the following restrictions:

1. The origin of this software must not be misrepresented; you must not claim that you wrote the original software. If you use this software in a product, an acknowledgment in the product documentation would be appreciated but is not required.

2. Altered source versions must be plainly marked as such, and must not be misrepresented as being the original software.

3. This notice may not be removed or altered from any source distribution.Jean-loup Gailly Mark Adler jloup@gzip.org madler@alumni.caltech.edu

The data format used by the zlib library is described by RFCs (Request for Comments) 1950 to 1952 in the files ftp://ds.internic.net/rfc/rfc1950.txt (zlib format), rfc1951.txt (deflate format) and rfc1952.txt (gzip format).
Glossary

The following terms are used throughout this guide:

**BMCA** — Best Master Clock Algorithm

**CBR** — Constant bit rate

**CDN** — Content distribution network

**DashBoard** — The DashBoard Control System

**Device** — A physical, virtual, or software application that may include multiple sources, destinations, senders, or receivers.

**Essence** — A single elementary logical media signal. For example, a video essence is one video channel. An audio essence is a single audio (mono) channel.

**Flow** — The continuous raw media content. It can contain more than one essence (e.g. an audio flow can contain multiple channels, and an SDI flow may contain audio and video essences).

**HLS** — HTTP Live streaming

**HTTP** — Hypertext Transfer Protocol

**MIB** — Management information base

**Module** — Refers to the NEWT-IPX.

**NTSC captions** — CEA-608-D: Line 21 Data Services captions

**PAL** — PAL-B and PAL-G unless otherwise stated

**PCR** — Program clock reference

**PID** — Packet identifier

**Production aperture** — The image lattice that represents the maximum possible image extent in a given standard (e.g. the full size of all active pixels and active lines). For example, the 1080i production aperture would be 1920x1080.

**Receiver** — An element within a device which that receives one stream, which contains one flow from a network.

**RTMP** — Real Time Messaging Protocol

**SDP** — Session Description Protocol

**Sender** — An element within a device which presents exactly one flow, packaged as a stream onto a network.

**SFP** — Small Form-factor Pluggable module

**Stream** — One flow, encapsulated within a transport protocol.

**System** — The mix of interconnected production and terminal equipment in your environment.

**TCP** — Transmission Control Protocol

**TOS** — Type of Service

**TPG** — Test Packet Generator

**TTL** — Time To Live

**UDP** — User Datagram Protocol